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1. Design of an in-line stormwater 
pond to meet pre-development 
conditions 

For new developments observed flow data for the “as-is” condition is usually absent, and an 
“as-is” model is developed to estimate pre-development runoff from the site. A detention 
pond is then sized to reduce the new or post-development (“to-be”) peak runoff to the 
estimated pre-development value. 

The limited time available for a workshop necessitate simplifying the steps required for this 
type of analysis. We'll start with the previously created "to-be" minor system model and 
remove the drainage structures to create the "as-is" model. 

 

1.1 Creating an “as-is” scenario to estimate pre-development flow 

First, let’s run the current project to generate results and title the project to indicate its 
purpose more clearly. We are using a previously made solution file to ensure there are no 
errors from previous Valleyfield exercise files. 

1. Open the Valleyfield to-be minor system.pcz from the PCSWMM 
Exercises\K019\Initial\ folder. 

2. Click on the File tab and then the Open button. 
3. Navigate to PCSWMM Exercises\K019\Initial\ and select Valleyfield to-be minor 

system.pcz. 
4. Click the Open button. 
5. A dialog will appear showing a default location to unpackage the model: click on 

the Unpackage button then the OK button. 

6. Click on the Run  button in the Project panel to generate computed results. 
7. Add a project description to "Valleyfield to-be minor system design (10y hydrotech 

design storm)". 
8. If no entity is currently selected, the Notes panel (located on the right side of the 

https://www.youtube.com/embed/ZuTc4vvwSZk
https://www.youtube.com/embed/ZuTc4vvwSZk
https://www.youtube.com/embed/ZuTc4vvwSZk
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main PCSWMM window) should display the Project Notes. If an entity is selected, 
ensure the Map panel has the focus and press the Esc. key. 

9. In the Notes panel, click on the Edit  button in the Description entry. 
10. Enter the following description: Valleyfield to-be minor system design (10y 

hydrotech design storm) and then click on the Save button (or press the Enter key) 
to save the note.  

 

Now let’s create a new scenario for the as-is model. A scenario is simply another SWMM5 
project, however by adding it to the PCSWMM scenario manager it is easier to switch 
between the projects. In addition, a number of useful scenario comparison tools become 
available. 

11. Duplicate the current scenario in the same folder, with the name "Valleyfield as-is", 
the abbreviation "As-Is", and the description "Pre-development peak flow 
estimation (10y hydrotech design storm)". 

12. Click on the Plan  (scenario manager) button in the toolbar of the Project panel 

13. In the Scenario Manager, click on the Add  button and select Duplicate Current 

Project . 
14. In the Create Scenario(s) dialog name the project Valleyfield as-is. 
15. Specify the location where your exercise is located (e.g. PCSWMM 

Exercises\K019\Initial). 
16. Enter in the Abbreviation to be As-is. 
17. Edit the Description (Title) text to read Pre-development peak flow estimation (10y 

hydrotech design storm). 
18. Click the Create button 
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19. The current project as well as the newly created scenario should appear in 

the Scenario Manager (under the Plan  button). Note that the currently loaded 
project is still the to-be project, as indicated by the name displayed at the top of 
the PCSWMM interface. 

20. Open the newly created As-is scenario. 

21. Click on the Plan  button. 
22. Select Valleyfield as-is and click Open to switch to the new scenario. 

 

23. Click on the Save Project  button in the Save Project message box to save the 
current scenario before switching. 

Do not save time series (if prompted). 

For the as-is model, we will remove the minor system drainage entities (conduits and 
junctions). We will then adjust the subcatchment routing and impervious area and run the 
model to produce an as-is runoff hydrograph at the outfall. 

Deleting junctions will automatically delete the connected conduits (because conduits must 
be connected to junctions). 

24. Select all the junctions in the Map panel and delete them. 
25. Select the Junctions layer in the Layer panel. 
26. Select all the junctions by pressing the Ctrl + A keys on the keyboard. 

27. Click the Delete  button or press the Delete key on your keyboard to remove the 
junctions. 

28. Click Yes in the Delete Shapes confirmation message.  

All conduits and junctions should be deleted, leaving only the subcatchments and an outfall. 

There are two ways to model the hydrology for the pre-development condition: 

aggregate the subcatchments into a single subcatchment, OR 

leave the subcatchments as they are and route the runoff from each subcatchment onto 
the next subcatchment towards the outfall. This is termed run-on and can be useful when 
routing overland sheet flow onto areas of differing hydrologic properties – for example 
routing an impervious area (say a parking lot) onto a pervious area. 

In our case, the hydrologic properties of the site are uniform and thus we will aggregate the 
subcatchments into a single subcatchment. Before aggregating the subcatchments, it is 
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recommended that you ensure that the boundaries of the subcatchments coincide cleanly. 

29. Use the Join  tool to combine all the subcatchments into one. 
30. Switch to the Subcatchments layer by clicking on the Subcatchments item in 

the Layers panel. 
31. Press the Ctrl + A keys to select all subcatchments. 

32. Click on the Edit  button in the Map panel and select Join from the list of 
items in the Edit browser. 

33. Click Analyze to preview the join operation. 
34. Click on the Apply button to aggregate the subcatchments, and click Close to exit 

the Join tool. 

If the boundaries of the subcatchments coincided, the resulting aggregated subcatchment 
should appear similar to the one illustrated below. The only remaining entities in the as-is 
model should be a single subcatchment and an outfall. 

 

If you have stray vertices, you could edit the new subcatchment shape to clean them up, 
however please note that this is for aesthetics only – the area computed by PCSWMM will not 
be affected significantly and thus there should be no significant effect on the SWMM5 
computed runoff.    

Let’s edit the attributes for the aggregated subcatchment. We will check the area, estimate 
the as-is overland flow path length and set the directly connected impervious area (DCIA) to 
0. 

35. Click on the Menu  button in the Map panel, select Preferences and in 
the General tab, check the Calculate subcatchment width box if it is not already 
checked. 

36. Click OK to close the Preferences. 
37. Select the subcatchment and check that the Area attribute is approximately 17 

acres | 7 hectares (as shown in the Attributes panel). 
38. In the Attributes panel, set the Outlet to Outfall. 
39. Set the Flow Length to 500 ft | 150 m. 
40. Set the % Impervious to 0.  

Now let’s run the as-is model and compare the runoff to the to-be scenario. 
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41. Click on the Run  button to run the model. 
42. After the run, ensure the continuity error is reasonable (< 1 %) by checking the run 

summary status results located at the bottom right hand side of the screen. 
43. In the Graph panel, plot the Total inflow for the Outfall. 
44. Switch to the Graph panel by clicking on the Graph tab. 
45. In the Time Series Manager, expand SWMM5 output > Nodes > Total Inflow and click 

on the checkbox for the Outfall location.  

46. In the Graph panel, click on the Scenarios  button. 
47. Check both scenarios are Visible and click on the Compare Scenarios button. 

Note: If a message appears saying PCSWMM is unable to locate a scenario, click on 
the Remove scenarios option. If this happens we do apologize, this is a result of scenarios not 
being removed while updating exercise files. 

The Graph panel’s scenario mode will turn on and the selected location will be plotted for 
both scenarios (as-is and to-be). For this rather frequent storm, the paved areas make a 
relatively large difference to the computed response (please note the screenshot is in US 
units, SI units will differ and your line colors may differ). 

 

The Show Scenario button can be used to toggle the scenario mode on and off. The Show 
Scenario button will display the Show Scenario pop-up editor, which can be used to change 
the color for each scenario (click on a colored square to change it). The color for a scenario 
is saved and is consistent for all plots when in the scenario mode. 
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48. Make a note of the pre-development peak flow from the Objectives tab below the 
plot in the Graph panel. Please note the screenshot is in SI units. 

 

In the Graph panel click on Tools  > Objective functions. 

The Objectives tab will appear in the bottom of the Graph panel. The Objective 
functions tool computes various statistics on one or more plotted time series on-the-fly in 
the Graph panel. Statistics include maximum, minimum, mean and total, as well as number, 
duration and volume of exceedances and deficits. Objective functions can be used to 
compare two or more time series, as well as quickly display statistics of events within the time 
series. 

In the Objectives tab, take a note of the peak flow (Maximum Total Inflow) for the as-is 
scenario (probably between 7 and 8 CFS | 0.17 - 0.22 m³/s). 

1.2 Sizing a detention pond to mitigate increases in peak flow 

Now we are ready to add a detention pond to the drainage system design (to-be model). 
The volume required for a storage pond can be determined using the Storage Pond 
Calculator tool in the Graph panel. 

1. Open the Valleyfield to-be minor scenario. 

2. Click on the Plan  button in the Project panel, select the Valleyfield to-be 
minor scenario and click on the Open button. 

3. Choose to Save  the project if prompted to.  
4. In the Graph panel, exit Scenario mode. 
5. Click on the Graph tab to open the Graph panel (if it is not open already). 

6. Click on the Scenarios  button in the Graph panel and click the Exit Scenario 
Mode button if you are still in scenario mode.  

7. Plot the Total inflow at the Outfall. 
8. In the Time series manager, expand the SWMM5 output to show Nodes > Total Inflow 

> Outfall. 
9. Check the Outfall to plot the hydrograph at the outfall.  

10. In the Graph panel, click on Tools  and select Storage Pond Calculator. 
11. In the Storage tab at the bottom of the panel, enter your recorded 

predevelopment peak flow (approx. ± 8 CFS | 0.21 m³/s) in the Maximum design 
outflow box. 
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12. Ensure the Available storage before outflow is set to 0 m3. 

The approximate storage requirement to meet the predevelopment peak flow is calculated 
as the area under the hydrograph (shown in blue). This tool provides a rough estimate of the 
storage required – it makes some simple assumptions about the outflow from the storage 
facility (shown with the blue line: outflow 1 is assumed to increase linearly with volume in the 
storage unit), but can be useful for a first estimate. (Please note the screenshot is in SI units, US 
units will differ). 

 

13. Make a note of the required storage volume. It should be approximately 27,000 
ft³ | 800 m³ (likely less). 

1.3 Creating a pond scenario 

Now let’s create a new scenario for developing the storage pond. As new scenarios created 
in the Scenario Manager are copies of the currently loaded scenario, it is important to ensure 
the current scenario is the Valleyfield to-be minor system project. 

1. Create a duplicate scenario called Valleyfield to-be pond, with the abbreviation 
"To-be Pond" and description "Valleyfield minor system detention pond design (10y 
hydrotech design storm)". 

2. Check that the model currently open is the Valleyfield to-be minor scenario (should 
be listed at the top of the interface). 

3. Click on the Plan  button in the Project panel. 

4. In the Scenario Manager, click on the Add  button and select Duplicate Current 

Project . 
5. In the Create Scenario dialog, name the project Valleyfield to-be pond. 
6. Set the Abbreviation to To-be Pond. 
7. Edit the Description item text to read Valleyfield minor system detention pond 

design (10y hydrotech design storm). 
8. Click the Create button.  
9. The new SWMM5 project should appear in the Scenario Manager. 
10. Switch to the new scenario by selecting it in the Scenario Manager and 

clicking Open. If prompted to save the current project, click on the Yes button. 

Now let’s add a storage unit to the model at the current outfall location. 

Convert the existing outfall to a storage node. 

11. Open the Map panel and click on the Outfall entity. 
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12. Right-click on the Outfall and select Convert > Storage from the drop-down box.  
13. If necessary, edit the storage layer to auto-calculate rim elevation instead of auto-

calculating depth, as we want to enter the pond depth manually. 
14. With the Storage entity selected, check the Attribute panel to see if 

the Depth attribute is disabled (gray), If not, skip the next 3 steps. 
15. If disabled, the depth will be calculated based on the difference between the rim 

and invert elevations, which is not what we want. To change this, click on 

the Depth attribute to select it, and then click on the small  button that appears 
in the Depth attribute to open the Auto-expression editor. 

 

16. In the Auto-expression editor, click on the Calculate Rim Elev. instead button. This 
will allow you to edit the Depth attribute as opposed to being automatically 
calculated using the defined auto-expression. 

17. Click Close. 
18. The outfall entity has been converted to a storage unit, however we still need to set 

its attributes. Let’s make the pond 6.56 ft | 2 m deep and have the sewer 
discharging near the top of the pond bank. 

19. In the Attributes panel for the converted entity, change the following parameters: 

Name = Pond 

Invert Elev. = 146.51 (ft) | 44.5 (m) 

Depth = 6.56 (ft) | 2 (m) 

Normally we would now create a stage / area curve to define the pond, however in the 
interest of time we will use a simple functional relationship. (If you have time at the end of the 
exercise, try your hand at using a TABULAR shape curve and entering a depth vs. area 
curve). 

Since we need a total storage volume of 27,000 ft³ | 800 m³, we simply divide this value by 
the depth of the pond to arrive at a constant area for the pond (in fact now a vertical 
walled tank). 

In the Attributes panel for the Pond storage entity, set: 

Storage Curve = FUNCTIONAL 

Coefficient = 0 

Exponent = 0 

Constant = 4116 (ft2) | 400 (m2) 
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Recall that we want the conduit discharging into the pond to have the same slope as the 
rest of the drainage pipe network and thus connect to the pond near the top. Since in the 
project offsets are specified in depths rather than elevations (see the Offsets setting in status 
bar in the lower left corner of the main PCSWMM window), we need to specify the depth 
above the pond invert at which the discharging conduit connects. We’ll set this depth so 
that conduit C8’s outlet elevation is the same as it was before we added the pond. We can 
use the Map panel to do this, however it can also be completed in the Profile panel. 

20. View the profile from node J1 to the storage Pond. 
21. In the Map panel, select a pathway through the system by clicking on the furthest 

upstream junction J1 (at the bottom of the Map panel) and, holding the Shift key 
down, clicking on the storage Pond. All intermediate nodes and conduits should be 
selected (highlighted in blue). 

22. Click on the Profile tab to switch to the Profile panel and see the drainage system 
profile along the selected pathway.  

23. If a warning appears notifying you that there are no results, choose Continue. 
24. You can see that since conduit C8’s outlet offset is 0, the conduit is currently steeply 

sloped and connected to the bottom of the pond. If the Offsets option was set 
to Elevation this would not have happened. 

25. Set the Outlet Offset for C8 to 3.06 (ft) | 1.1 (m). 
26. In the Profile panel, select conduit C8 by clicking on it in the profile plot. When 

selected the conduit lines turn red and its attributes are displayed in the Attributes 
panel. 

27. In the Attributes panel for conduit C8, set the Outlet Offset = 3.06 (ft) | 1.1 (m). If the 
conduit slope became negative when you applied the offset it is likely because you 
did not change the invert elevation of the pond to 44.5 m as outlined earlier in step 
5. 

28. Press the Enter key or switch away from the Outlet Offset attribute item (e.g. click on 
another attribute or in the profile plot) to commit the change and see the new 
profile.  

Note: You can also graphically edit the outlet offset for conduit C8 directly in the Profile 
panel. Before doing this it is a good idea to save your project first. To do this, entering Edit 
mode (click on the Edit button in the toolbar), click on conduit C8 in the profile plot to select 
it and then drag the right-most handle (red dot) up and down to set the Outlet offset 
attribute. This method does not give as much accuracy, but can be faster, especially when 
used for sizing conduits (in which case the diameter of the pipe snaps to standard pipe sizes). 

Now we need to create an outfall below the pond and an outlet entity to connect the pond 
to the outfall and define the head / outflow relationship of the pond’s outlet structure. 

Note: you can model the physical structure of the outflow devices using a combination of 
one or more orifices and weirs, as an alternative to defining a head vs. outflow relationship. 
One advantage of this latter approach is that it can more accurately model reverse flow 
conditions and/or backwater effects from the water surface elevation downstream of the 
pond. (If you have time at the end of the exercise, try your hand at replacing the outlet 
entity with an orifice and weir combination. You can also add a second, higher and larger 
weir to model a spillway i.e. have one orifice and 2 weirs draining the pond in parallel). 

In the Map panel, switch to the Outfalls layer and click on the Add  button. 

Add an outfall somewhat north of the pond and set its attributes as follows: 
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Name = Outfall 

Invert El. = 144.36 (ft) | 44 (m) 

Type = FREE 

29. Switch to the Outlets layer and click on the Add  button. The Outlets layer will 
appear grayed out in the Layers panel as there are not Outlets in the model as of 
yet. 

30. Draw an outlet joining the Pond by clicking on the pond then on the new Outfall, 
and set its attributes as follows: 

 

Name = PondOutlet 

Rating Curve = TABULAR/DEPTH 

We’ll use a tabular rating curve to illustrate the method of creating and assigning curves. 

31. Create an outlet rating curve PondOutlet and assign it to the outlet using the Rating 
Curve info in the screenshot below. 

32. With the Outlet selected, click on the Curve Name attribute in the Attributes 

panel and an ellipsis  button will appear. Click on this button to launch the Rating 
Curve editor. 

33. In the Rating Curve editor, click on the Add button to create a new curve. 
34. Name the new curve PondOutlet and enter the following data in 

the Head vs. Outflow table (click the image below to see the data). 
35. Click on the Assign to Outlet PondOutlet button to save your changes.  

Rating curve info: 
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The Rating Curve editor opens in a mode that allows you to set the rating curve for the 
selected entity. You should notice the Rating Curve editor’s title bar indicates the selected 
entity. PCSWMM presents the Rating Curve editor, rather than a simple drop-down list of 
curve names, to provide more information during the selection of the curve and also to 
provide the option of adding or editing curves during the selection process. This mode only 
applies if a curve editor is launched from the Attributes panel for a selected entity. Launching 
a curve editor from the Project panel opens it in a neutral mode (i.e. doesn’t affect the 
assigning of curves). 

Please note that normally a pond outlet rating curve will be more complex than the one just 
specified. 

Now let’s run the model to evaluate the performance of the pond. 

36. In the Map panel, click the Select  button to exit edit mode. 

37. Click on the Run  button to execute a SWMM5 run. 
38. Plot the Flow for the PondOutlet and Volume and Depth for the Pond. 
39. Switch to the Graph panel. 
40. In the Time series manager expand the following SWMM5 output, and plot: 

Links > Flow > PondOutlet 

Nodes > Volume > Pond 

Nodes > Depth > Pond 

Please note the screenshot is in US units, SI units will differ. 

 

The outflow from the pond will hopefully meet the pre-development target and the pond’s 
water surface elevation should not reach its bank elevation. 

We can use the scenario mode to compare the outfall hydrograph for all three scenarios. 

41. In the Graph panel, click on the Menu  button and select Clear Graph. 
42. Plot the Total Inflow for the Outfall node (Nodes > Total Inflow > Outfall). 
43. View and compare the hydrographs for all three scenarios. 

44. Click on the Scenarios  button in the Graph panel. 
45. In the Show Scenarios editor, place a check in all three scenario check-boxes and 

adjust the colors as necessary. 
46. Click on the Compare Scenarios button to enter scenario mode. 
47. Click Close to exit the Show Scenarios editor (please note the screenshot is in US 

units, SI units will differ)  
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The comparison plot should look similar to the one here (line colors may vary). The objective 
functions below the plot can be used to view statistics on the three time series, including their 
peak (maximum) values. 

 

It is important to note that the objective functions are computed on the plotted time series 
and are thus dependent on the Reporting time step set in the Simulation Options editor. They 
may differ from the statistics reported in the Status panel, which are computed using the 
routing time step being used by the SWMM5 engine. The statistics reported in the Status 
panel (i.e. the SWMM5 report file) should take precedence in all cases. The plotted time 
series can more accurately reflect the computed values by reducing the Reporting time 
step, however this creates more data points to be loaded and plotted. 

Let's compare the outfall loading summary table in SWMM's status report. 

48. Switch to the Status panel by clicking on the Status tab 

49. Click on the Split window vertically  button in the upper right corner of the Status 
panel (alternatively, if your screen resolution is small, you may prefer to choose 

the Split window horizontally  button). 
50. Click on the Scenario drop-down menu button and select the Valleyfield to-be 

minor scenario. 

 

51. In the Sections list on the left (under Project panel) select Outfall Loadings. 
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52. The Status panel should display the peak outfall flows for the two scenarios (in 
the Outfall Loading Summary tables). 

Let’s look at the Project Summary/Comparison tool, which generates tables of both model 
inputs and results for multiple scenarios. 

53. Switch to the Map panel and open the Summary/Comparison tool (Tools menu). 

54. Click on the Map tab and click on the Tools  button in the Map panel. 
55. In the Auditing section, click on the Summary/Comparison tool. 

56. In the Summary/Comparison tool, click the Show Scenarios  button and select all 
three scenarios.  

57. In the Summary Tables list, select Results statistics. Scroll down to see the full results 
table. 

58. In the results table, compare the scenario values for: 

Max. subcatchment total runoff 

Max. subcatchment peak runoff 

Max. subcatchment runoff coefficient 

Num. conduits surcharged 

Max. storage percent full 

Max. outfall peak flow 

Total outfall volume 

 

Valleyfield as-is scenario is missing some values from this table as it did not contain any 
hydraulic routing components. For more insight to how the Valleyfield as-is model 
performed, examine the Runoff quantity continuity table:    

59. Select the Runoff quantity continuity table in the Summary Tables list. 
60. Compare the mass balance values in this table and ensure they make sense. 
61. Close down the Project Summary/Comparison tool when finished. 
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62. Finally, let’s take a look at the animation of the profile through the pond. 
63. Animate the results in the Profile panel for J1 to the Outfall. 
64. Select a pathway (using the Shift key) from junction J1 to outfall Outfall. 
65. Switch to the Profile panel to see the peak values for head displayed in the plot 

(hint... Menu | Show Peak Values). 

66. Click on the Play  button in the bottom left corner of the Profile panel to 
playback the computed HGL in the profile plot.  

The slider bar at the bottom of the profile has start and stop pointers that can confine the 
playback to a specific time period of interest. Playback speed can be adjusted in 

the General section of the Profile Properties display (click on Properties  button in 
the Profile panel). Playback can also be manually controlled by dragging the slider. 
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2. Estimating subcatchment attributes 
based on land-use and soils layers 

This example illustrates the steps a planner or engineer may consider if there was a change in 
a subdivision design to incorporate a small park. In this example, 8 of the subcatchment 
attributes will be calculated based on a land-use and soils map. 

Normally the user would re-discretize subcatchments however, for simplicity sake, this 
example uses the same subcatchment discretization created in earlier Valleyfield exercises. 

Subcatchment attributes can be calculated based on a land-use layer. User-defined 
attributes matching those in the subcatchment layer can be added to a land-use layer in 
order to obtain an area-weighted average of the subcatchment parameters. In this section 
the user-defined attributes IMPERV, NIMPERV, NPERV, PSPERV and DSIMPERV have already 
been added to the land-use layer for you. 

Another approach for estimating SWMM attributes is through the use of look-up tables. In the 
second part of this exercise we will estimate subcatchment infiltration using a soils layer in 
combination with a look-up table. 

 

2.1 Rendering a land-use map 

1. Unpackage the Valleyfield to-be pond - solution.pcz file from the PCSWMM 
Exercises\K022\Initial folder. Ensure you Merge and update existing look-up tables. 

2. Click File and select the Open button. 
3. Browse to the folder PCSWMM Exercises\K022\Initial. Open Valleyfield to-be pond - 

solution.pcz. 
4. Click the Open button. 
5. A dialog will appear showing a default location to unpackage the model: click on 

the Unpackage button then the OK button. 
6. If PCSWMM notifies you of look-up table information, choose to Merge and update 

existing tables. 

https://www.youtube.com/embed/JyPrpW4Esj0
https://www.youtube.com/embed/JyPrpW4Esj0
https://www.youtube.com/embed/JyPrpW4Esj0
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7. Click on the Run  button. 

8. Open  the background layers photo-grande-ile.jpg and Land-Use 
Valleyfield.shp files from the PCSWMM Exercises\K022\Initial folder. 

9. Click the Open  button in Map panel. 

10. Click the Browse button and navigate to PCSWMM Exercises\K022\Initial. 
11. Select the raster image photo-grande-ile.jpg.  
12. Hold down the Ctrl key and select the Land-Use Valleyfield.shp file. 
13. Click on the Open button. 
14. In the Layers panel arrange the layers (by dragging-and-dropping) so that Land-Use 

Valleyfield.shp overlies photo-grande-ile. 
15. Click on the File tab and select Save As... 
16. Change the name of the project to Valleyfield Area-weighting and click Save. 

It is a good habit to render a layer based on the attribute of interest. In this case the assigned 
land-use is of greatest interest. 

Render the land use layer with sections based on the LAND_USE attribute and the wiki-
2.0 color ramp. Make the layer 50% transparent and add a land use label. 

17. Click on the Render  button in the Map panel. 
18. Select the Land-Use Valleyfield layer from the list of layers. 
19. Click on the Sections drop-down box to open the Section creator. 
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20. Click on the Attribute drop-down list and select LAND_USE as the attribute to render 
on. 

21. Click on the color ramp drop-down box and click wiki-2.0 from the list of available 
ramps (you can see the ramp name by holding your mouse over a ramp) and 
click Select. 

 

22. Click on the Create sections button. 
23. Change the Opacity slider bar to around 50%. 

 

24. Click on the Label button and click on Insert. 
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25. Place a check beside the LAND_USE attribute. 
26. Click Insert, Apply and then Close. 

The Map panel should look something like the illustration below (colors may vary). 

 

2.2 Performing area-weighting from Land-use layer attributes 

1. Click the Table tab to open the Table panel and select Land-Use Valleyfield from 
the Layers panel. 

Examine the values in the table. You should notice that there are 8 attributes, 5 of which we 
will use to calculate the subcatchment attributes (please note the screenshot shown is in SI 
units, US units will differ). 

 

The 5 attributes that will be used for the area-weighting can be found in following table (click 
view to open the image). 

 

Some of these values were estimated using the following Reference Tables listed on the 
PCSWMM support site: 

Manning's N - Overland flow for N Imperv, N Perv 

Depression storage for Dstore Imperv, Dstore Perv 

https://secure.chiwater.com/Workbook/Exercise.aspx?pcswmmcode=2&ChapterID=22&ChapterNum=6&ScheduleID=134&WorkbookID=15&License=837662&Email=water@hydrosoft.co.kr&v=kjnyyjuAOkhsmcr1AVvJzS8rMUQ7nwi5TckpM%2bSmrtmMdEd0GuC%2boHzd9SVW0HgPFGqTV494go%2biqkB%2bTRfzpQgN6HGmIZLPMNih6MPMwJGOFgXVx5pCYgw7Z7rn2gXuQdgsE%2bLmYDs2TWujpjXUrcGm0T66az1oiMQkFo3uwaLu4uHyCyn%2fMvqtLLtEidqxzFZKyQhBEM4NrxScPFTdYJZTh0Z2Aq96wQIlPqugALmKjm%2fdn9ZRrrLk%2bLNaLSbPRDQqQ8%2bCgqTyMY6Do%2bmDXaIMKyBQWK8F6Kx6yx6pdR8%2foN7wi8DgCCC6ib8q%2bVXm
https://secure.chiwater.com/Workbook/Exercise.aspx?pcswmmcode=2&ChapterID=22&ChapterNum=6&ScheduleID=134&WorkbookID=15&License=837662&Email=water@hydrosoft.co.kr&v=kjnyyjuAOkhsmcr1AVvJzS8rMUQ7nwi5TckpM%2bSmrtmMdEd0GuC%2boHzd9SVW0HgPFGqTV494go%2biqkB%2bTRfzpQgN6HGmIZLPMNih6MPMwJGOFgXVx5pCYgw7Z7rn2gXuQdgsE%2bLmYDs2TWujpjXUrcGm0T66az1oiMQkFo3uwaLu4uHyCyn%2fMvqtLLtEidqxzFZKyQhBEM4NrxScPFTdYJZTh0Z2Aq96wQIlPqugALmKjm%2fdn9ZRrrLk%2bLNaLSbPRDQqQ8%2bCgqTyMY6Do%2bmDXaIMKyBQWK8F6Kx6yx6pdR8%2foN7wi8DgCCC6ib8q%2bVXm
https://secure.chiwater.com/Workbook/Exercise.aspx?pcswmmcode=2&ChapterID=22&ChapterNum=6&ScheduleID=134&WorkbookID=15&License=837662&Email=water@hydrosoft.co.kr&v=kjnyyjuAOkhsmcr1AVvJzS8rMUQ7nwi5TckpM%2bSmrtmMdEd0GuC%2boHzd9SVW0HgPFGqTV494go%2biqkB%2bTRfzpQgN6HGmIZLPMNih6MPMwJGOFgXVx5pCYgw7Z7rn2gXuQdgsE%2bLmYDs2TWujpjXUrcGm0T66az1oiMQkFo3uwaLu4uHyCyn%2fMvqtLLtEidqxzFZKyQhBEM4NrxScPFTdYJZTh0Z2Aq96wQIlPqugALmKjm%2fdn9ZRrrLk%2bLNaLSbPRDQqQ8%2bCgqTyMY6Do%2bmDXaIMKyBQWK8F6Kx6yx6pdR8%2foN7wi8DgCCC6ib8q%2bVXm
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Note: You should notice how the attributes are named. These names are the subcatchment 
field names recognized by PCSWMM. By having these attributes named with the 
subcatchment field names in the land-use map, the area-weighing tool will automatically 
recognize the attribute and match it with the same attribute in the subcatchments layer. 
Otherwise the user can manually select the matching layer attributes.  

2. Click on the Tools  button in the toolbar of the Map panel to open the Tools 
Browser. 

3. Click on the Spatial Weighting tool (in the Subcatchments, Nodes and 
Conduits sections). 

4. In the Spatial Weighting tool, set the Data source layer to Land-Use Valleyfield and 
the Destination layer to Subcatchments. Change the Method to Area Weighting. 

5. Click on the Next button. 

 

The area weighting tool option in the Spatial Weighting tool calculates the value of one or 
more attributes for entities in a polygon layer (e.g. the SWMM5 Subcatchments layer, or any 
other layer) by area-weighting matching attributes from the intersecting entities on a source 
polygon layer. 

Note: The Spatial Weighting dialog displays a table with two columns. The first column 
displays the destination layer attributes (Subcatchment attributes) while the second contains 
drop-down lists of the attributes in the data source layer (Land-Use Valleyfield attributes). 
Because the land-use and subcatchment attributes have identical field names, the area-
weighing tool can identify the 5 attributes to be used for the area-weighting calculation.    

Ensure the destination layer (Subcatchment) attributes are properly matched with the data 
source layer (Land-Use Valleyfield) as shown below: 
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6. Click on the Calculate button to perform the area-weighting operation. A report 
should appear saying that 9 entities on the Subcatchment layer have been 
updated. 

In the report, you should notice that for each of the subcatchments both the old and new 
values are displayed for each of the subcatchment attributes updated. You will also notice, 
in the Spatial weighing report, the number of Land-Use components (polygons) located in 
the boundaries of each of the subcatchments. Also listed is the percentage of area for each 
component located in each subcatchment. The sum of these fractions should equal 1.0, 
meaning that 100% of the subcatchment area has been accounted for in the Land-Use 
Valleyfield layer. 

7. Click the Close button to close the report. 
8. Select the Land-use Valleyfield layer and click the Close button to remove it from 

the list of layers. 

2.3 Opening up a soils background layer 

Soils layers commonly consist of the spatial distribution of soil types for a specific area. Soil 
layers can be valuable in setting up a SWMM model, as they allow for the infiltration 
properties for the subcatchments be estimated in setting up a SWMM model. 

1. Open  and unlock the Soils layer Valleyfield.shp background layer in 
the PCSWMM Exercises\K022\Initial folder. 

2. Click the Open layer  button in the Map panel. 

3. Click on the Browse button and open PCSWMM Exercises\K022\Initial\Soils 
layer Valleyfield.shp. 

4. Click on the Soils layer Valleyfield layer in the Layers panel and click 

the Lock/Unlock button and then click Unlock layer.   



25 

 

The soils layer should look like the screen capture below (you may have to move the soils 
layer up in the layers list or un-check the Land-Use Valleyfield.shp layer). 

 

Examine the attributes for the soils layer in the Table panel. 

5. Click on the Table tab to open the Table panel. 

If the attributes for the Soils layer Valleyfield are not already being displayed, click the Soils 
layer Valleyfield layer from the Layers panel (should be located close to the bottom of the 
layers list). 

Examine the given attributes and notice the attributes provided including the UNIT, ID, 
SOILTYPE and GIS coordinates 

The infiltration type selected for the Valleyfield model was Green-Ampt. The Green-Ampt 
equations require three input attributes: Suction Head (Ψ), Conductivity (K) and Initial 
Deficit (WP). 

2.4 Estimating subcatchment infiltration based on the soils layer 

The subcatchment Green-Ampt infiltration attributes can be estimated using the soils layer in 
conjunction with a lookup table. This is also done using the Spatial Weighting tool. 

The infiltration attributes required by the subcatchment layer are the SUCTHEAD (Suction 
head), CONDUCT (Conductivity) and INITDEFICT (initial deficit). Infiltration parameter values 
related to soils can be found on the PCSWMM support site in the Soil 
characteristics and NRCS hydrologic soil group definitions reference tables. 

The Spatial Weighting tool will match up the attributes between the soils layer and the 
subcatchment layer and can be used to estimate the subcatchment infiltration attributes. 

1. Open the Map panel and click on the Tools  button in the toolbar of the Map 
panel to open the Tools Browser. 

2. Click on the Spatial Weighting tool, (in the Subcatchments, Nodes and Conduits 
sections). 

3. In the Spatial Weighting tool, set the Data source layer to Soils layer Valleyfield, 
the Destination layer to Subcatchments, and change the Method to Area 
Weighting. 

4. Place a check next to the Use look-up table option. 

https://secure.chiwater.com/Workbook/Exercise.aspx?pcswmmcode=2&ChapterID=22&ChapterNum=6&ScheduleID=134&WorkbookID=15&License=837662&Email=water@hydrosoft.co.kr&v=kjnyyjuAOkhsmcr1AVvJzS8rMUQ7nwi5TckpM%2bSmrtmMdEd0GuC%2boHzd9SVW0HgPFGqTV494go%2biqkB%2bTRfzpQgN6HGmIZLPMNih6MPMwJGOFgXVx5pCYgw7Z7rn2gXuQdgsE%2bLmYDs2TWujpjXUrcGm0T66az1oiMQkFo3uwaLu4uHyCyn%2fMvqtLLtEidqxzFZKyQhBEM4NrxScPFTdYJZTh0Z2Aq96wQIlPqugALmKjm%2fdn9ZRrrLk%2bLNaLSbPRDQqQ8%2bCgqTyMY6Do%2bmDXaIMKyBQWK8F6Kx6yx6pdR8%2foN7wi8DgCCC6ib8q%2bVXm
https://secure.chiwater.com/Workbook/Exercise.aspx?pcswmmcode=2&ChapterID=22&ChapterNum=6&ScheduleID=134&WorkbookID=15&License=837662&Email=water@hydrosoft.co.kr&v=kjnyyjuAOkhsmcr1AVvJzS8rMUQ7nwi5TckpM%2bSmrtmMdEd0GuC%2boHzd9SVW0HgPFGqTV494go%2biqkB%2bTRfzpQgN6HGmIZLPMNih6MPMwJGOFgXVx5pCYgw7Z7rn2gXuQdgsE%2bLmYDs2TWujpjXUrcGm0T66az1oiMQkFo3uwaLu4uHyCyn%2fMvqtLLtEidqxzFZKyQhBEM4NrxScPFTdYJZTh0Z2Aq96wQIlPqugALmKjm%2fdn9ZRrrLk%2bLNaLSbPRDQqQ8%2bCgqTyMY6Do%2bmDXaIMKyBQWK8F6Kx6yx6pdR8%2foN7wi8DgCCC6ib8q%2bVXm
https://secure.chiwater.com/Workbook/Exercise.aspx?pcswmmcode=2&ChapterID=22&ChapterNum=6&ScheduleID=134&WorkbookID=15&License=837662&Email=water@hydrosoft.co.kr&v=kjnyyjuAOkhsmcr1AVvJzS8rMUQ7nwi5TckpM%2bSmrtmMdEd0GuC%2boHzd9SVW0HgPFGqTV494go%2biqkB%2bTRfzpQgN6HGmIZLPMNih6MPMwJGOFgXVx5pCYgw7Z7rn2gXuQdgsE%2bLmYDs2TWujpjXUrcGm0T66az1oiMQkFo3uwaLu4uHyCyn%2fMvqtLLtEidqxzFZKyQhBEM4NrxScPFTdYJZTh0Z2Aq96wQIlPqugALmKjm%2fdn9ZRrrLk%2bLNaLSbPRDQqQ8%2bCgqTyMY6Do%2bmDXaIMKyBQWK8F6Kx6yx6pdR8%2foN7wi8DgCCC6ib8q%2bVXm
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5. Click on the Next button. 

At the top of the Spatial Weighting dialog there is a look-up table drop down box. Select 
the Soil characteristics SI units or Soil characteristics US units depending on what units you 
are using. The Spatial Weighting tool will display a table of default infiltration values for 
different soil types. 

Note: In this example we are using a pre-defined lookup table however you can create a 
new one for your custom layers. For instructions on how to create a look-up table for the 
Spatial Weighting tool see the following article from our support site: 
https://support.chiwater.com/77973/area-weighting-with-a-look-up-table 

  

Note: The look-up table uses attributes that match the destination layer (i.e. SOILTYPE, 
CONDUCT, SUCTHEAD and INITDEFICT). If the look-up table attribute names were not found in 
the destination layer an error message would have appeared in the Spatial 
Weighting dialog. 

6. Click Calculate to perform the area weighting calculation with the selected look-up 
table. 

https://support.chiwater.com/77973/area-weighting-with-a-look-up-table
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The Spatial Weighting report shows the number of Soils layer Valleyfield components 
(polygons) intersecting each subcatchment. Also listed is the percentage of area for each 
component located in each subcatchment. The sum of these fractions should equal 1.0, 
meaning that 100% of the subcatchment area has been accounted for in the Soils layer 
Valleyfield. 

7. Click the Close button to close the report. 
8. In the Map panel, select a subcatchment and inspect the Green-Ampt Infiltration 

attributes to ensure they are reasonable. 

9. Click on the Run  button the model and check that the continuity results are 
reasonable. 

2.5 Troubleshooting 

A common problem users have with this exercise is not being able to see or select the 
correct look-up table from the Spatial Weighting tool. This error is the result of not selecting 
the option to Merge and update look-up tables indicated in step 1. This step is important as 
the look-up tables needed for this exercise are stored in the packaged model. 

You can correct this by doing the following: 

Close the currently opened PCSWMM model. 

Re-open the packaged project located in PCSWMM Exercises\K022\Initial and unpackage it 
in a different location. This will prevent you from loosing your work on the first model. Ensure 
you select the option to Merge and update look-up tables. 

Close the newly un-packaged model and re-open the original model. 

You should now be able to see the look-up tables from the drop-down box. 
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3. Simulating water quality (Valleyfield, 
Quebec) 

This exercise illustrates how to model the water quality aspect of an urban residential 
stormwater drainage system. In this example, we define the pollutants of interest, assign land 
uses to each subcatchment, and simulate pollutant removal from a stormwater pond. 

 

3.1 Setting up a model 

First, let's create a new scenario and title the current project to indicate its purpose more 
clearly. 

1. Open Valleyfield to-be pond-solution.inp from the PCSWMM 
Exercises\K023\Initial\ folder. 

2. Launch PCSWMM and click File > Open. 
3. Browse to PCSWMM Exercises\K023\Initial\ and select Valleyfield to-be pond-

solution.inp.  
4. Make a duplicate scenario of the current project named Valleyfield to-be water 

quality and open it. 

5. Click on the Plan  button in the toolbar of the Project panel. 

6. In the Scenario Manager, click on the Add  button and select Duplicate Current 
Project. 

7. Name the project Valleyfield to-be water quality. 
8. In the Description (Title) box edit the text to read Valleyfield water quality analysis. 
9. Click the Create button to close the Create Scenario window. 
10. Click on the newly created Valleyfield to-be water quality scenario from 

the Scenario manager and click Open.  
11. If the background image did not automatically open, load photo-grande-

ile.jpg from the PCSWMM Exercises\K023\Initial\ folder. 

12. Click the Open layer  button in Map panel. 

https://www.youtube.com/embed/Bs8H8VbMEks
https://www.youtube.com/embed/Bs8H8VbMEks
https://www.youtube.com/embed/Bs8H8VbMEks
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13. Click on the Open  button and navigate to PCSWMM Exercises\K023\Initial, 
select the raster image photo-grande-ile.jpg and click Open.  

3.2 Adding pollutants to the Pollutant Editor 

The pollutants to be modeled in this example are TSS, phosphorus, and nitrates. 

1. In the Project panel, click on the downward arrow and select Pollutants (see 
screenshot provided). It will be grayed out as there are currently no pollutants 
defined. 

 

2. In the Pollutant Editor, click the Add button. 
3. In the Name attribute type TSS and set the units to be MG/L. 
4. Repeat steps 2-3 to add Phosphorus and Nitrates pollutants all in units of MG/L. 

 

5. When complete click on the OK button to close the Pollutant Editor. 

6. Save your changes to the model by clicking on the Save  button in the Project 
panel. 
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3.3 Adding land uses to the land-use editor 

1. In the Project panel click on Land Uses to open the Land Use Editor. It will appear 
grayed out as there are currently no land uses assigned to the model. 

2. Click the Add button and type Residential in the Land Use Name attribute. 
3. Switch to the Washoff Tab and select Nitrates in the pollutant drop-down menu. 
4. In the Attributes table ensure that the Function is set to EMC, and set 

the Coefficient to 1.075, as shown in the screenshot provided. 

 

5. While still in the Washoff tab, select Phosphorus from the drop-down menu and set 
the coefficient to 0.28. Set the TSS coefficient to 72. 

6. Click Add two times to define two new land uses (select Yes if prompted to save the 
changes). 

7. Name the new land uses: Transportation and OpenSpace. 
8. Enter the Washoff coefficients for these land uses using Washoff information from the 

table shown in the image. (Click to view the table). 

 

Disclaimer: The values presented were delivered by a third party and are solely provided for 
the purpose of this example and are not necessarily representative of conditions outside of 
this study area. 

9. Click OK to close the Land Use Editor. 
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3.4 Assigning subcatchment land-uses for pollutant modelling 

This section illustrates one of the many uses for the Spatial Weighting tool. In this case, a land-
use layer will be used to determine the percentages of each land use in each 
subcatchment. To do this, we will edit the background land-use layer to add the attributes in 
preparation for the area-weighting operation. 

1. Open the Land-Use Valleyfield.shp background layer from the PCSWMM 
Exercises\K023\Initial\ folder. 

2. Click the Open  button in the Map panel. 

3. Click on the Browse  button and open PCSWMM Exercises\K023\Initial\ and 
select Land-Use Valleyfield.shp.  

4. Click on the Render  button and ensure the Land-Use Valleyfield layer is 
selected. 

5. Click on the Sections button and select LAND_USE as the attribute to render on. 
6. Choose wiki – 2.0 as the color ramp to render to and click on the Select button. 

 

7. Put a check beside the Random sampling option and click on the Create 
sections button. 

8. Slide the Opacity slider bar to around 50% and click Apply and Close. 
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9. Select the Land-Use Valleyfield layer from the Layers panel. 

10. Unlock the layer by right-clicking the layer and selecting Unlock  . 
11. Add three Number-type attributes to the land-use 

layer: RESIDENT, OPENSPACE and TRANSPORT. 

 

12. Click the Alter  button in the Map panel and select Restructure. 

13. Click on the Add  button and select Attributes from the drop-down menu 
14. Under Name type RESIDENT and under Data Type select Number. 
15. Add two more attributes by repeating steps 10 and 11 

for OPENSPACE and TRANSPORT and define the two new attributes with 
the Type defined as Number. 

16. Click Save to add the user-defined attributes to the Land-use layer and close the 
dialog. 

17. Select all the land-use polygons named Residential, and set the RESIDENT attribute 
value to 100. 

 



33 

 

18. Click on the Find  button in the Map panel and choose to Select by Query. 
Under Layer select Land-Use Valleyfield, 
under Attribute select LAND_USE, for Operator select =, and 
for Value select Residential and click Select. 

19. Keeping the Select by Query dialog open, go to the Attributes panel and change 
the attribute RESIDENT to 100 (to represent the areas that are 100% residential area). 
Leave the other attributes OPENSPACE and TRANSPORT at 0. 

20. Select all the land-use polygons named OpenSpace, and set 
the OPENSPACE attribute value to 100. 

< style="display:none;" p> 

Now in the Select by Query window, change the Value to OpenSpace and click Select. 

21. Without closing the Select by Query dialog, in the attribute Attributes 
panel set OPENSPACE to 100. Leave the other attributes at 0 

22. Select all the land-use polygons named Transport, and set the TRANSPORT attribute 
value to 100. 

< style="display:none;" p> 

23. Back in the Select by Query window change the Value to Transport and 
click Select. 

24. You can now click Close to close the Select by Query window and, in the Attributes 
panel, set the attribute TRANSPORT to 100. Leave the other attributes at 0. 

25. Now we will apply the percentage of each land use to the Subcatchment attributes 
we created using area weighting. 

26. Click on the Tools  button and in the Subcatchments section select the Spatial 
Weighting tool. 

27. In the Spatial Weighting tool, set the Data source layer to Land-Use 
Valleyfield, the Destination layer to Subcatchments and the Method to Area 
Weighting. Click Next. 

 

28. Click the Clear all button to clear the assumed matched parameters. 
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29. Match up the attributes Transportation with TRANSPORT, 
Residential with RESIDENT, and Open Space with OPENSPACE in the Spatial 
Weighting dialog. 

 

30. Click Calculate to apply the area-weighted subcatchment attributes. 
31. Click the Close button to close the summary. 
32. Select Subcatchments in the Layers panel, select various subcatchments, and 

ensure that there are now values for the Land Uses attributes in the Attributes panel. 

 

3.5 Simulating pollutant removal from pond 

Pollutant removal in a storage or junction node can be modeled in PCSWMM using 
treatment functions entered by the user in the Treatment Editor. For more information please 
see our Treatment article available from our support site. 

Let’s assign the pond’s removal efficiency for each pollutant. 

1. Select the Pond entity in the Map panel. 

https://secure.chiwater.com/Workbook/Exercise.aspx?pcswmmcode=2&ChapterID=23&ChapterNum=7&ScheduleID=134&WorkbookID=15&License=837662&Email=water@hydrosoft.co.kr&v=kjnyyjuAOkhsmcr1AVvJzS8rMUQ7nwi5TckpM%2bSmrtmMdEd0GuC%2boHzd9SVW0HgPFGqTV494go%2biqkB%2bTRfzpQgN6HGmIZLPMNih6MPMwJGOFgXVx5pCYgw7Z7rn2gXuQdgsE%2bLmYDs2TWujpjXUrcGm0T66az1oiMQkFo3uwaLu4uHyCyn%2fMvqtLLtEidqxzFZKyQhBEM4NrxScPFTdYJZTh0Z2Aq96wQIlPqugALmKjm%2fdn9ZRrrLk%2bLNaLSbPRDQqQ8%2bCgqTyMY6Do%2bmDXaIMKyBQWK8F6Kx6yx6pdR8%2foN7wi8DgCCC6ib8q%2bVXm
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2. In the Attributes panel, under the Treatment attribute heading, click on 

the ellipsis  button to the right of the Nitrates Treatment attribute to display the 
pond Treatment Editor. 

3. At the bottom of the Treatment Editor window there is a brief explanation of how to 
input the pond treatment expressions. 

4. In order to express the removal efficiency as an expression in the Treatment 
Editor, type in the expression R = 0. This means that 0% of the nitrates in the 
stormwater will be removed in the pond. 

5. Click Apply to Nitrates Treatment. 

 

6. Click on the ellipsis  button next to Phosphorus Treatment, enter R=0.2 to indicate 
that 20% of Phosphorus will be removed in the pond. 

7. Click Apply to Phosphorus Treatment. 

8. Click on the ellipsis  button for TSS Treatment, enter R=0.5 to indicate that 50% of 
TSS will be removed in the pond. 

9. Once complete, click the Apply to TSS Treatment. 

10. Run the simulation by clicking on the Run  button in the Project panel. 
11. Note that the project is automatically saved when a simulation is run. 

3.6 Interpreting results 

1. Check water quality Continuity Errors (runoff and routing) in the Status Report. 
2. Switch to the Graph panel. 
3. In the Time Series Manager, select Links > Nitrates > C8 and PondOutlet. 
4. Repeat step 3 for Phosphorus and TSS and compare the concentration differences. 

Zoom in on a couple of events and check to see that the concentration differences 
make sense. 
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The plot above is zoomed in to show how the concentration of pollutants decreased in the 
pond. 

3.7 References 

Toronto and Region Conservation. 2012. Stormwater Management Criteria Draft. Version 1.0. 

Ministry of the Environment, Ontario. 2003. Stormwater Management Planning and Design 
Manual. 

Toronto and Region Conservation. 2012. Characterization of particle size distributions of runoff 
from high impervious urban catchments in the Greater Toronto Area 
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4. Post-processing 1D-2D urban flood 
analysis 

This exercise reviews the post-run analysis options available in PCSWMM for 2D modeling, 
including plan view animation, risk map generation, video production and velocity analysis. 

You will need to have Google Earth downloaded on your computer to complete this 
exercise. Google Earth can be downloaded at the following 
link: http://www.google.com/earth/. 

 

4.1 Post processing 

In the previous chapter we built an integrated 1D-2D model and ran it. Now we are ready to 
analyze the results, starting with thematically rendering the 2D cells to indicate maximum 
flood extent and maximum flood depths. There are several default rendering options that 
can be easily applied to the 2D entities. Let’s begin by rendering the 2D cells using the Max 
depth attribute of the 2D cells layer. 

1. Unpackage 2D Model.pcz from the PCSWMM Exercises\K002\Initial folder (or 
continue with your completed 2D model from the previous chapter if you prefer). 

2. Click File > Open . 
3. Browse to the PCSWMM Exercises\K002\Initial folder and select 2D Model.pcz. 
4. Unpackage the model to PCSWMM Exercises\K002\Initial\. 
5. Click OK.  
6. Render the 2D cells to show cell maximum depths. 

7. Click on the Tools button and select 2D modeling from the list of tool categories. 
8. Select Render 2D network from the 2D modeling sub menu. 
9. Select Show Cell Max. Depths to render the cells based on the maximum depth 

reached during the simulation.  

Now we will project model results onto Google Earth, by rendering on the maximum water 
depth computed for the 2D cells. We will use the Extrude function to provide a 3D 

https://secure.chiwater.com/Workbook/Exercise.aspx?pcswmmcode=2&ChapterID=2&ChapterNum=13&ScheduleID=134&WorkbookID=15&License=837645&Email=jin@hydrosoft.co.kr&v=EqZc2R4A316goBtYmFrs2nHFMENZjh3pI28eFtjRhbaqUWIjSfEO08gP5e%2bufDH1Ha4E0DqSFUNb2XEgf%2fNQ08z0i2spVsAxbxXAnlqcwIFA9i3akOMxFyiICD3%2fguzh0ab00uXaOYXtxXgdaq0J4RJHdyu%2bU2SMxvCeTC40fyEto2OmIM9YCpYkgeOqBHfCsf96b0JCelRGGijKLKjeWEZ9wgi%2f9RCDMIcyhrsLhWE073VK60Htj89wGO4aVurYtbiaQEXG8GuC6ieFYYRpoQ5ocMc7AekI66jEdngzAI%2fcKIzzWziEZhPG3KFdmTQF
https://www.youtube.com/embed/0Y0CexJTYfw
https://www.youtube.com/embed/0Y0CexJTYfw
https://www.youtube.com/embed/0Y0CexJTYfw
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visualization of the 2D cells (this is optional). To do this we will first need to set the coordinate 
system. 

10. Set the coordinate system to RGF93 CC46. 

11. Click on the Menu  button in the Map panel and select Coordinate system. 
12. Select Projected system. 
13. Delete the word All from the filter box and type in RGF93 into the filter and press 

the Find button. 
14. Select RGF93 CC46 from the list of options and click OK. A message may appear 

asking if you would like to make this the default coordinate system. Click on the 
option to Keep existing coordinate system. 

15. Another message may appear asking if you wish to apply the coordinate system to 
the other layers. Click on the Yes button to set the other layers coordinate system.  

16. Click on the down arrow beside the Google Earth  button in the Map panel. If 
you are using a low resolution, you will not see an arrow; simply click on the button. 

17. Under View layers, scroll down and check the 2D cells layer. 
18. Ensure this is the only layer checked (uncheck all other layers). 

19. Click the Export Extrude  button beside the 2D cells layer. 

 

20. Click on the View  button to see the results in Google Earth. 

In Google Earth you can select the exported model results in the Places tree list (on the left 
side of the Google Earth interface) and reduce the opacity with the Adjust Opacity button. 
You can also pan and rotate the Google Earth view as required. 

Optionally, you can return to PCSWMM and regenerate the layer in Google Earth without the 
extrude option. Simply click on the drop-down beside the Google Earth button in the Map 
panel, uncheck the Export Extrude button, and click on the View button. The existing model 
layer in Google Earth will be updated. 
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4.2 Animate 2D simulation 

An advantage to modeling in 2D is the ability to animate the computed flood inundation 
area. We will start by dynamically rendering the map to show instantaneous computed 
water depths during the simulation. Please note that when you are in 2D playback mode you 
cannot pan, zoom or edit within the Map panel. 

1. In the Map panel, click on the drop-down menu beside the Play  button. 

 

2. Ensure that only the Depth box is checked and the Scheme is rendered from white 
to dark blue. 



40 

 

3. Click Show animation. 

4. Click the Play  button on the bottom of the Map panel to start the animation. 
5. Click on the Pause button to stop the animation 
6. You can also use the slider to quickly move back and forth through the animation. 
7. Drag the slider bar forward and backwards through time. 
8. Stop the slide bar at around 01/30/2012 2:30 AM. 

Exit the animation view by clicking on the Animate/Play  button. The 2D cell attributes 
including Depth, Volume and Time (time that the computed water depth was reached) will 
be updated to correspond with the time at which the animation was stopped. 

4.3 Create a flood risk map 

One of the 2D capabilities in PCSWMM is the ability to create contour maps and flood risk 
maps. Risk maps use SQL query statements and can be based on any of the attributes of the 
2D cells layer (including user-defined attributes that the user creates and populates). The 
generated map layers can be accessed by any GIS or CAD program, as they can be saved 
in any of the supported GIS/CAD file formats. They can also be exported as georeferenced 
raster images, or viewed in Google Earth / Google Maps. 

1. Click on the Tools button and select 2D modeling. 
2. Choose Create Risk Map from the 2D modeling sub menu. 

3. In the Create Risk map window, click on the New button beside the Risk map 
layer drop-down menu. 

 

4. Navigate to PCSWMM Exercises\K002\Initial and save the newly created layer as a 
shape file using the default name RiskMap and click Save. 

5. In the Zones table, click on the white box beside the 1 (i.e. first row, second 
column). This allows the user to define the colour that will be displayed for the 
defined zone 1. In this case we will start with yellow and progress to red. 

6. Select a bright yellow colour and click OK. 
7. Click in the Name box for zone 1 and type in Low. 
8. Click in the Description box for zone 1 and type in Low risk. 

9. Click in the SQL box for zone 1 and click on the ellipsis  button. 
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We will now build a query that specifies the criteria for zone 1. For this exercise we will define 
zone 1 to include 2D cells with a maximum depth between 0 m and 1 m and a maximum 
velocity less than 0.5 m/s. Note that you can simply type in the SQL query directly in the SQL 
box, however in this exercise we will use the Query Builder. 

Set up a query for 2D cells with a maximum depth greater than 0 m, less than 1 m and a 
maximum velocity less than 0.5 m/s. 

10. Click on the Add button to add a statement. 
11. Select Max. Depth under the Attribute drop-down menu, select greater 

than > under the Operator drop-down menu and leave the Value set to 0. 
12. Click on the Add button to add a second statement. 
13. Change the Operator to less than < and change the value to be 1. 
14. Click on the Add button to add to the statement. 
15. Change the Attribute to Max. Velocity, the Operator to be less than < and 

the Value to be 0.5. 
16. Click Apply to apply the query to risk zone 1. 

 

Now we will build a query for zone 2. We will define this zone to include 2 sets of criteria: cells 
with a maximum depth between 0 m and 1 m and a maximum velocity between 0.5 m/s 
and 1 m/s, and cells with a maximum depth greater than 1 m but with a maximum velocity 
less than 0.5 m/s. 

17. In the Zones table click on the white box beside the 2 (i.e. second row, second 
column). 

18. Select an orange color and click OK. 
19. Click in the Name box for zone 2 and type in Medium. 
20. Click in the Description box for zone 2 and type in Medium risk. 

Now we will define our criteria for zone 2. 

21. Click on the ellipsis  button for zone 2 to open the Query Builder. 
22. Set up a query for cells with either 1) a maximum depth greater than 0 m, less than 1 

m and a with maximum velocity greater than 0.5 m/s and less than 1 m/s or 2) a 
maximum depth greater than 1 m and a with maximum velocity less than 0.5 m/s. 

23. The SQL query should read as follows... 
24. (MaxDepth > 0 AND MaxDepth < 1 AND MaxVelocit > 0.5 AND MaxVelocit < 1) OR 

(MaxDepth > 1 AND MaxVelocit < 0.5) 
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25. Click on the Add button to add a statement. 

26. Click on the Left bracket  button 
27. Select Max. Depth under the Attribute drop-down menu, select greater 

than > under the Operator drop-down menu and leave the Value set to 0. 
28. Click on the Add button to add a second statement. 
29. Change the Operator to less than < and change the value to be 1. 
30. Click on the Add button to add to a third statement. 
31. Change the Attribute to Max. Velocity, the Operator to be greater than > and 

the Value to be 0.5. 
32. Click on the Add button to add another statement. 
33. Change the Operator to be less than < and the Value to be 1. 

34. Click on the Right bracket  button to complete the first criterion. 
35. Click on the Add button to add another statement. 
36. Click on the OR button. 

37. Click on the Left bracket  button. 
38. Change the Attribute to be Max. Depth. 
39. Change the Operator to be greater than > and the value to be 1. 
40. Click on the Add button to add another statement. 
41. Change the Attribute to be Max. Velocity. 
42. Change the Operator to be less than < and the value to be 0.5. 

43. Click on the Right bracket  button to complete the second criterion. 
44. Click Apply to apply the query to risk zone 2. 

 

Now we will build the query for the final (third) zone. This zone represents the highest risk and 
includes areas where the maximum depth is greater than 1 m and the maximum velocity is 
greater than 0.5 m/s. 

45. In the Zones table click on the white box beside the 3 (i.e. third row, second 
column). 

46. Select a red color and click OK. 
47. Click in the Name box for zone 3 and type in High. 
48. Click in the Description box for zone 3 and type in High risk. 

49. Click on the ellipsis  button for zone 3 to open the Query Builder. 
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50. Set up a query for cells with a maximum depth greater than 1 m and a maximum 
velocity greater than 0.5 m/s. The SQL query should read as follows: MaxDepth > 1 
AND MaxVelocit > 0.5 

51. Click on the Add button to add a statement. 
52. Select Max. Depth under the Attribute drop-down menu, select greater 

than > under the Operator drop-down menu and change the Value set to 1. 
53. Click on the Add button to add a second statement. 
54. Change the Attribute to Max. Velocity, the Operator to be > and the Value to 

be 0.5. 

 

55. Click Apply to apply the query to risk zone 3. 

 

56. Click on the Create button to generate the risk map layer and exit the Create Risk 
Map tool. 

In the Layers panel, uncheck the 2D cells layer (to hide it) and in the Map panel, select 

the Menu  button and then check Show Legend. Observe the extent of each of the risk 
zones in the new risk map layer, and note that this may also be viewed in Google Earth as 
described above. 
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4.4 Create a video 

Now we will record a video showing the water depth. Videos can be created from either 
plan view animations in the Map panel, or profile animations in the Profile panel. Video 
creation is part of the PCSWMM Professional version and can be used for normal 1D model 
animations as well as the 2D animations we will be recording here. To record a video, simply 
click on the Record button when in animate/playback mode in either panel. 

1. Turn off the RiskMap layer from the Layers panel (i.e. uncheck it). 
2. Render the 2D network to hide all 2D entities. 

3. Click on the Tools  button and select 2D modeling. 
4. Under 2D modeling select Render 2D network. 
5. Click on Hide All to hide the 2D junctions, conduits and outfalls.  
6. Zoom in on the Map to show the extent of the area you wish to include in the video. 

7. Click on the drop-down menu beside the Animate/Play button. 
8. Ensure that only the Depth box is checked and the Scheme is rendered from white 

to dark blue. 
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9. Click the Show animation button. 

Now let’s choose the start and ending times for the video. Note that this step is optional and 
you can record a video of any length, including the full simulation period. 

10. Use the playback scroll bar to find a suitable starting point for the video. 
11. Move the Start marker (green arrow) to the selected starting point (see screenshot). 

 

Again, use the playback scroll bar to find a suitable ending point for the video. 

12. Move the End marker (red arrow) to the chosen stopping point. 

13. Click on the Stop button  to move the scroll bar to the Start marker position. 
Note the Stop button will be grayed out if the scroll bar is already at the starting 
point. 

Now we are ready to record a video showing the animated water depth for the selected 
time period. 

During the recording session, the Map panel will playback the simulation and record the 
screen. The Create Video tool allows you to specify the video quality, the video speed (i.e. 
duration) and the size of the video. PCSWMM provides a list of standard video sizes such as 
Full HD (1080p), HD (720p), XGA, etc. and also provides support for any custom video 
resolution. However, the video resolution cannot be greater than the screen resolution. Thus 
we recommend a high resolution monitor for recording Full HD or greater resolution videos. 

Let’s setup and record the video: 

14. Click the Record  button on the bottom of the Map panel. 
15. In the Create Video dialog click on the folder button to browse. 

 

16. Browse to PCSWMM Exercises\K002\Initial, name the video 2D video and click 
the Save button to return to the Create Video tool. 

17. Set the Compression (i.e. video quality) to Medium quality, medium file. 
18. Set the Size to Youtube & HD (1280 X 720) if you can. If your screen resolution 

doesn’t allow this, use the default custom size (i.e. the current Map panel resolution) 
or choose a smaller size from the list. 
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19. Set the Length to 20 seconds to speed up the playback. Note that the Rate (in 
frames per second) adjusts accordingly. 

20. Click on the Record button. The recorder will automatically stop recording once the 
simulation duration is complete. 

Once complete a message will appear asking if you wish to view the video (e.g., using 
Windows Media Player) or show the file location. Choose to View video. 

Once you have finished watching the video, return to PCSWMM and save your model. 

4.5 Animate with velocity vectors 

1. Click on the drop-down menu beside the Animate/Play  button. 
2. Check the Velocity vectors check box. 
3. Click the Update animation button. 

Animate your results and observe the velocity vectors. 

Note that to zoom into a specific location for a detailed view of the velocity vectors, you will 
need to temporarily exit the animation mode. Also note that you can control the size of the 
velocity vectors in the Animation/Play pop-up editor. 
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5. Automatic watershed delineation 
with a DEM 

This exercise will demonstrate the creation of a DEM-based open channel model in an urban 
setting. For simplicity, only watercourses will be represented in the model, other hydraulic 
structures such as bridges, culverts, and pipes will not be included. The watershed delineation 
tool will be used to generate the SWMM5 layers for this model. Note that this model is for 
instructional purposes; it is fictional and therefore only suitable for use in this exercise. 

 

5.1 Create the project and load the DEM and burn-in streams 

1. Create a new project called YellowRiver in the PCSWMM 
Exercises\K1190\Initial folder. 

2. Launch PCSWMM. 
3. Click the File tab then click the New button. 
4. Choose to create a new SWMM5 Project. 
5. Name the project YellowRiver. 
6. Browse to the folder PCSWMM Exercises\K1190\Initial as the location to save the 

project. 
7. Click the Create Project button.  
8. Set the Map coordinate system to NAD83 Georgia East ft US and Apply to all layers. 

9. In the Map panel, click on the Menu  button and select Coordinate system. 
10. Click on Projected system. 

https://www.youtube.com/embed/EeIevBQMvB4
https://www.youtube.com/embed/EeIevBQMvB4
https://www.youtube.com/embed/EeIevBQMvB4
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11. Under Filter type in "NAD83 Georgia" and press the Find button. 

 

12. Choose NAD83 Georgia East ft US. 
13. Check Apply to all layers. 
14. Click OK. 

Since this exercise is located in the U.S., we will set up the project to use U.S. units. 

Set the flow units to CFS. If you are working in the United States you can skip this step as your 
flow units should automatically be set to CFS. 

15. Click on Simulation Options from the Project panel. 
16. In the Simulation Options dialog, under the General tab, change the Flow 

units to CFS. 

 

17. Click on the OK button. 
18. Select the Switch button when asked. 
19. A burn-in streams layer and DEM will be loaded for use with the watershed 

delineation tool and flood inundation analysis. 
20. Open the Burn-in Streams.shp and ClippedDEM.FLT layers from the PCSWMM 

Exercises\K1190\Initial folder. 

21. Click on the Open layer  button and press the Open  button in the top right 
corner. 
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22. Navigate to PCSWMM Exercises\K1190\Initial. 
23. Hold down the Ctrl key and select Burn-in Streams.shp and ClippedDEM.FLT and 

click Open. 

 

5.2 Add an outfall 

First, an outfall must be placed to indicate to the tool the most downstream point for the 
hydrology/hydraulics model. 

In the Layers panel, click on the Outfalls layer. It will be grayed out to indicate the layer is 
currently empty. 

1. Click on the Add  button and add an outfall at the southern end of the "Burn-in 
Streams" line layer. See the screenshot for reference. Note that it is important the 
outfall is located in the darker green channel portion of the DEM as shown (i.e., the 
elevation should be in the range of 216-217 ft, as indicated by the Z value in the 
bottom status bar). 

 

2. Click on the Select  button to exit add mode. 
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3. Now the invert elevation of the outfall can be updated from the DEM. 

4. Click on the Tools  button. 
5. In the Nodes section, choose Elevation from DEM. 
6. Select the DEM layer to be ClippedDEM. 
7. Choose the Point layer to be Outfalls. 
8. Choose the DEM elevation attribute to be Invert Elev. 

 

9. Click Apply then OK when a report appears. The outfall invert elevation will be 
updated to match the DEM (approximately 216-217 ft, depending on where the 
outfall is located). 

5.3 Automatically generate hydrology and hydraulic model parameters 

Now the junctions, conduits, and subcatchments will be created for the model using 
the Watershed Delineation Tool (WDT) in PCSWMM. 

1. Click on the Tools  button. 
2. In the Subcatchments section, choose Watershed Delineation. 
3. In the WDT dialog, ensure the DEM layer has been set as ClippedDEM. 

A burn-in stream layer specifies the line layer to be used for delineating flow paths. The burn-
in streams option carves a trench in the original DEM along the specified line layer and 
removes any obstructions in the flow such as bridges or dams. 

4. Choose the Burn-in stream layer to be the Burn-in Streams layer from the drop-
down menu. 

5. Click on the Advanced  button and set the stream width to 50 feet. 

 

6. Click Save. 
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7. Change the Target discretization level to 500 acres. This represents the desired 
average area for the created subcatchments. This coarse resolution was chosen for 
illustration purposes, normally a higher resolution would be used. 

 

8. Click the Delineate watershed button to create the SWMM5 layers for the model. 
9. It may take a minute for PCSWMM to create the entities. When the operation is 

complete, a summary report will appear. Click Close to close the report. 

Note: If the WDT tool doesn't generate any entities (0 subcatchments, 0 conduits, etc.), 
check that the coordinate system for all the layers and map is set to NAD83 Georgia ftUS 

under Menu  > Coordinate systems. Additionally, check that the outfall is located in 
the dark green portion of the DEM. Re-try using the WDT tool without the Burn-in Streams 
layer selected. 

10. The model will appear in the Map panel. In the Layers panel, uncheck the WDT Flow 
Paths, ClippedDEM and Burn-in Streams layer to view the model. It may appear 
slightly different than the one shown in the image. 

 

11. Click on a subcatchment entity and in the Attributes panel, view the different 
attribute values. Using the WDT, the subcatchment area, slope, width, flow length, 
and outlet attribute values have all been automatically assigned. 
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Elevations for junctions and conduit inlet/outlets have also been assigned based on the DEM. 
Conduit lengths have been calculated from the coordinate system and GIS properties. 

Note: The WDT generates several different layers that will be visible in the Layers panel. Turn 
on and off these layers to view the different components that are used to generate the 
watershed hydrology and hydraulic parameters. For more information on these layers and 
how the tool creates them, please see the Watershed Delineation article on the PCSWMM 
support site. 

Other attributes such as roughness, depression storage, percent impervious and initial depths 
must still be specified by the user as the WDT does not automatically generate these 
parameter values (SWMM5 default values are used). 

In this example, values from the PCSWMM support site Reference Tables will be used to 
parameterize the subcatchment values. For simplicity and to save time in this exercise, the 
same values will be applied for all the subcatchments. For the Dstore Imperv and Dstore Perv 
values, the Depression storage article was used to determine values for the depression 
storage based on an assumed land use from satellite imagery (Bing Map satellite tiles). The 
satellite imagery was also used to determine the ground cover for assigning the N Imperv 
and N Perv values with the aid of the Manning's N - Overland flow article. Percent impervious 
was also estimated based on the satellite imagery. 

In a real model, a land-use and soils layer would be used to determine the exact locations of 
soils and land use to accurately assign these values. The values can then be weighted using 
the soil and land use polygons with the Area weighting tool. 

12. Click on the Subcatchments layer in the Layers panel. 
13. Press the Ctrl+A keys on the keyboard to select all of the entities. 
14. In the Attributes panel, enter in the following values for the attributes. 

 

Conduit roughness values will also be assigned based on the estimated roughness of the 
Yellow River channel. Roughness value for natural channels can be obtained from 
the Manning's N - Open channels article on the PCSWMM support site. 

https://secure.chiwater.com/Workbook/Exercise.aspx?pcswmmcode=2&ChapterID=1190&ChapterNum=15&ScheduleID=134&WorkbookID=15&License=837662&Email=water@hydrosoft.co.kr&v=kjnyyjuAOkhsmcr1AVvJzS8rMUQ7nwi5TckpM%2bSmrtmMdEd0GuC%2boHzd9SVW0HgPFGqTV494go%2biqkB%2bTRfzpQgN6HGmIZLPMNih6MPMwJGOFgXVx5pCYgw7Z7rn2gXuQdgsE%2bLmYDs2TWujpjXUrcGm0T66az1oiMQkFo3uwaLu4uHyCyn%2fMvqtLLtEidqxzFZKyQhBEM4NrxScPFTdYJZTh0Z2Aq96wQIlPqugALmKjm%2fdn9ZRrrLk%2bLNaLSbPRDQqQ8%2bCgqTyMY6Do%2bmDXaIMKyBQWK8F6Kx6yx6pdR8%2foN7wi8DgCCC6ib8q%2bVXm
https://secure.chiwater.com/Workbook/Exercise.aspx?pcswmmcode=2&ChapterID=1190&ChapterNum=15&ScheduleID=134&WorkbookID=15&License=837662&Email=water@hydrosoft.co.kr&v=kjnyyjuAOkhsmcr1AVvJzS8rMUQ7nwi5TckpM%2bSmrtmMdEd0GuC%2boHzd9SVW0HgPFGqTV494go%2biqkB%2bTRfzpQgN6HGmIZLPMNih6MPMwJGOFgXVx5pCYgw7Z7rn2gXuQdgsE%2bLmYDs2TWujpjXUrcGm0T66az1oiMQkFo3uwaLu4uHyCyn%2fMvqtLLtEidqxzFZKyQhBEM4NrxScPFTdYJZTh0Z2Aq96wQIlPqugALmKjm%2fdn9ZRrrLk%2bLNaLSbPRDQqQ8%2bCgqTyMY6Do%2bmDXaIMKyBQWK8F6Kx6yx6pdR8%2foN7wi8DgCCC6ib8q%2bVXm
https://secure.chiwater.com/Workbook/Exercise.aspx?pcswmmcode=2&ChapterID=1190&ChapterNum=15&ScheduleID=134&WorkbookID=15&License=837662&Email=water@hydrosoft.co.kr&v=kjnyyjuAOkhsmcr1AVvJzS8rMUQ7nwi5TckpM%2bSmrtmMdEd0GuC%2boHzd9SVW0HgPFGqTV494go%2biqkB%2bTRfzpQgN6HGmIZLPMNih6MPMwJGOFgXVx5pCYgw7Z7rn2gXuQdgsE%2bLmYDs2TWujpjXUrcGm0T66az1oiMQkFo3uwaLu4uHyCyn%2fMvqtLLtEidqxzFZKyQhBEM4NrxScPFTdYJZTh0Z2Aq96wQIlPqugALmKjm%2fdn9ZRrrLk%2bLNaLSbPRDQqQ8%2bCgqTyMY6Do%2bmDXaIMKyBQWK8F6Kx6yx6pdR8%2foN7wi8DgCCC6ib8q%2bVXm
https://secure.chiwater.com/Workbook/Exercise.aspx?pcswmmcode=2&ChapterID=1190&ChapterNum=15&ScheduleID=134&WorkbookID=15&License=837662&Email=water@hydrosoft.co.kr&v=kjnyyjuAOkhsmcr1AVvJzS8rMUQ7nwi5TckpM%2bSmrtmMdEd0GuC%2boHzd9SVW0HgPFGqTV494go%2biqkB%2bTRfzpQgN6HGmIZLPMNih6MPMwJGOFgXVx5pCYgw7Z7rn2gXuQdgsE%2bLmYDs2TWujpjXUrcGm0T66az1oiMQkFo3uwaLu4uHyCyn%2fMvqtLLtEidqxzFZKyQhBEM4NrxScPFTdYJZTh0Z2Aq96wQIlPqugALmKjm%2fdn9ZRrrLk%2bLNaLSbPRDQqQ8%2bCgqTyMY6Do%2bmDXaIMKyBQWK8F6Kx6yx6pdR8%2foN7wi8DgCCC6ib8q%2bVXm
https://secure.chiwater.com/Workbook/Exercise.aspx?pcswmmcode=2&ChapterID=1190&ChapterNum=15&ScheduleID=134&WorkbookID=15&License=837662&Email=water@hydrosoft.co.kr&v=kjnyyjuAOkhsmcr1AVvJzS8rMUQ7nwi5TckpM%2bSmrtmMdEd0GuC%2boHzd9SVW0HgPFGqTV494go%2biqkB%2bTRfzpQgN6HGmIZLPMNih6MPMwJGOFgXVx5pCYgw7Z7rn2gXuQdgsE%2bLmYDs2TWujpjXUrcGm0T66az1oiMQkFo3uwaLu4uHyCyn%2fMvqtLLtEidqxzFZKyQhBEM4NrxScPFTdYJZTh0Z2Aq96wQIlPqugALmKjm%2fdn9ZRrrLk%2bLNaLSbPRDQqQ8%2bCgqTyMY6Do%2bmDXaIMKyBQWK8F6Kx6yx6pdR8%2foN7wi8DgCCC6ib8q%2bVXm
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15. Click on the Conduits layer in the Layers panel. 
16. Press the Ctrl+A keys on the keyboard to select all of the entities. 
17. In the Attributes panel, enter in a value of 0.05 for Roughness. 

5.4 Create Conduit Cross-Sections 

Now that the initial hydraulic model has been generated, the Transect Creator tool can be 
used to quickly create and assign conduit transects. Conduits are assigned a default cross-
section that is circular with a set diameter. The Transect Creator offers a fast and accurate 
way to assign channel cross-sections to conduits based on the DEM. 

1. Click on the Tools  button, select Conduits, then select Transect Creator. 
2. Click the Transect lines tab. 
3. Ensure ClippedDEM has been identified as the DEM layer in the first drop down box. 
4. Set the Channel centerline layer to be Conduits. 

5. Click on the Advanced  button beside the Channel centerline layer drop-down 
box. 

The advanced options allows a user to apply smoothing for the centerline. Since the 
lines are initially drawn perpendicular to the flow path line, straightening this line can 
result in improved transects, especially in the case of meandering rivers. The advanced 
options also allow a user to specify the number of flow lines that will be used to draw the 
full transect. These lines are used to better represent the river shape and flood plains, by 
following the river centerline and drawing the transect to the closest vertex on each flow 
line. PCSWMM also allows the flow lines to be straightened, for better representation of 
the floodplains. For this exercise we will use the default advanced options. 

6. Click on the OK button to close the advanced options. 

7. Beside the Transect layer drop-down menu click on the New  button. 
8. Navigate to PCSWMM Exercises\K1190\Initial and type Transects as the File name. 
9. Click on the Save button. 
10. Beside Transect spacing enter a value of 750 ft. 
11. Beside the Transect length enter a range of 200 - 1600 ft. 
12. Beside the Station spacing box enter a value of 5 ft. 
13. For Auto-shorten transect length select the None option. 
14. Set the Transect use filter to 1. 
15. Toggle on the checkbox to Keep invalid transects. 
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16. Click Create. If a warning that "-- invalid floodplain transect lines were found" 
appears, click Yes to delete them. 

17. An Error Report will appear. Click Close followed by Close to close the Transect 
editor. 

18. Transects are based on the DEM and grouped according to the nearest conduit. 
These will be automatically assigned and added to the Map panel. 

Note: Transects can also be manually drawn using the Ruler  tool. The transect data 

can then be copied from the Attributes panel Cross-section  and pasted to 
the Transect Editor as station elevation data to create transect objects for irregular-type 
conduits. 

19. Click on a transect to view the elevation profile as shown in the Attributes panel. 
Transects are drawn from left to right facing downstream. If the transect isn't shown, 

click on the View button and choose Cross-Section . Transects shown in the 
screenshot may not exactly match those in your model. 
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Now Transect Objects can be created. This adds the station and elevation data from each 
transect line to the input file and allows transects to be assigned as cross-sections for irregular 
type conduits. 

20. Click on the Tools  button, select Conduits, then select Transect Creator. 
21. Click the Transect objects tab. 
22. Ensure the ClippedDEM has been identified as the DEM layer in the first drop-down 

box. 
23. Beside the Transect layer drop-down select the Transects layer that was created 

above. 
24. Leave the Overbank layer and Roughness layer blank. 
25. For the Channel representation method, select to Average the transects intersecting 

each conduit. 
26. Check the option to Assign conduit name to transect. 

 

27. Click Analyze. 
28. If the Transect Creator dialog indicates that "One or more intersecting conduits are 

not irregular type conduits" (i.e. the default conduit type is circular shape), 
select Change conduit type. 

29. A Transect Creator report will appear with the details of the analysis. 
Click Apply then Close. The transects will now appear in the Transects Editor which 
can be accessed from the Project panel. 
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30. In the Map panel select the conduits layer and click Ctrl + A to select all the 
conduits in the layer. Check all the conduits have been assigned IRREGULAR cross-
section. 

Note: To assign different roughness coefficients to portions of the transects, you can define 
overbank stations in the Transect editor (accessed through the Project panel). For this 
exercise, a single roughness value will be used with no defined bank stations.   

5.5 Assign a rain gage to subcatchments 

To run the model, subcatchments must have a rain gage assigned to them. 

1. Click on the Graph tab to open the Graph panel. 

2. In the Graph panel, click on the Add  button to open the Design Storm Creator. 
3. In the Design Storm Creator dialog, choose an SCS storm. 
4. Set the Total rainfall to 5 inches. 
5. Change the type to Type II. 
6. Set the Storm duration to 24 hour. 
7. Set the Rain interval to 15 minutes. 
8. Choose the Rain Format to be Intensity. 
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9. Click the button to Create Time Series & Setup Model. This option assigns the rain 
gage to all the subcatchments and sets the Simulation Options, Dates tab to match 
the design storm selected. 

10. Click the Map tab to return to the Map panel. 
11. In the Project panel, click on the Simulation Options. 
12. In the Dates tab, change the Duration to 36 hours. Since large subcatchments were 

generated, the simulation duration must allow enough time for the water to fully 
runoff the subcatchments and to be routed through the hydraulic network. 

13. Click OK. 

14. Click on the Run  button to run the model. There should be flooding indicated in 
the status bar. 

5.6 Next steps 

If this was a real model, the flooding should be corrected as it indicates a loss of water in the 
system which can lead to high continuity errors. By clicking on the Flooding notification in 
the Status bar, the Status panel will open and display the status report for the model. 
The Node flooding section will indicate which nodes are flooding and for how long and by 
how much. To model the flooding, the 1D flood inundation analysis, or integrated 1D-2D 
flood modeling can be used. Please see those exercises for further instructions. 

In addition, in a real scenario, the user would need to go through each transect line in the 
model and ensure the transect has been correctly sampled. To edit a transect, select the 
transect, double click to enter edit mode and drag the left and right vertices so the full 
transect is captured. 
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6. Design of a sanitary sewer system 
with a force main (Valleyfield, 
Quebec) 

This exercise illustrates the design of a sanitary sewer system using PCSWMM. In this example, 
we develop a preliminary design for a sanitary sewer drainage system. The system comprises 
manholes and pipes and a pumping station with a force main - capable of handling the dry 
weather flow with inflow and infiltration - for a new development of approximately 80 single-
family detached residences in Valleyfield, Quebec. 

 

6.1 Set up a new SWMM project 

Let’s begin by opening a project with the background layers for the Valleyfield sanitary 
sewer design: 

1. Unpackage PCSWMM Exercises\K027\Initial\Valleyfield_sanitary.pcz. 

2. Launch PCSWMM and click the Open  button in the File menu. 
3. Browse to the PCSWMM Exercises\K027\Initial\Valleyfield_sanitary.pcz and 

click Open. 
4. Unpackage the model to PCSWMM Exercises\K027\Initial 
5. Click the Open button.  

 

https://www.youtube.com/embed/vu8peUEUN80
https://www.youtube.com/embed/vu8peUEUN80
https://www.youtube.com/embed/vu8peUEUN80


59 

 

The CAD drawing appears, delineating the proposed lots and roadways in yellow. 

Note: Model units are set to GPM | LPS as the flows associated with the model are small in 
magnitude (i.e., compared to the default CFS | CMS flow units). 

For this exercise we need to design the sanitary sewer network that will convey wastewater 
from all residential buildings on the proposed lots. The area is relatively flat and must be 
graded to ensure that minimum slopes are achieved. We will be entering the invert elevation 
at the downstream location and from there the manhole invert elevations will be calculated 
by setting the slope using the set slope tool in PCSWMM. 

6.2 Locate the sanitary sewer manholes (junctions) 

To begin with, we will locate an outfall (to simulate a pump wet well) and the manholes in 
the network, using a maximum distance of 500 ft | 160 m between manholes, and ensuring 
the placement of a manhole at every intersection and change in pipe direction. We will 
begin by adding an outfall. 

1. In the Layers panel, click the Outfalls item, the layer will appear grayed out as there 
are currently no Outfalls in the project. 

2. Click the Add  button in the toolbar and click just outside of the blue CAD 
boundary on the west side of the subdivision (see screenshot provided). 

 

3. Click the Select  button in the toolbar to exit the Add mode. 
4. With the outfall node selected, go into the Attributes Panel and change the Invert 

Elevation to 147.6 ft | 45 m. 

We will be positioning the junctions according to a GIS background layer provided. 

5. Open the Junctions outline.SHP layer from the PCSWMM 
Exercises\K027\Initial folder. 

6. Click the Open layer  button in the Map Panel. 

7. Click the Open button in the Layer Browser window. 
8. Navigate to the folder PCSWMM Exercises\K027\Initial, select Junctions 
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outline.SHP and click Open.  

Keep in mind the junctions outline layer is just a background points layer and does not 
represent SWMM5 junctions. We will now copy and paste the junctions outline points and 
paste them to the SWMM5 junctions layer and draw conduits connecting the junctions. 

9. Unlock the Junctions outline layer and select all the nodes. 
10. Select the Junctions outline layer from the Layers panel. 

11. Right click on the layer and select Unlock . A message will appear asking if you 
want to unlock or copy the layer, click on Unlock layer. 

12. Press Ctrl + A to select all of the points in the Junctions outline layer.  
13. Press Ctrl + C to copy the junctions. 
14. Select the Junctions layer from the Layers panel, the layer will appear grayed out as 

there are currently no Junctions in the project. 
15. Press Ctrl + V to paste the points into the Junctions layer. 
16. Right click on the Junctions outline.SHP layer in the Layers panel and click 

the Close  . 
17. We will now add conduits to connect the junctions. 
18. Click on the Conduits layer in the Layers panel. It will appear grayed out as there 

are currently no conduits in the model. 

19. Click the Add  button in the toolbar. 
20. Click on J1 and then click on J2. A pop up may appear asking if you wish to turn 

Auto length on. Click Yes to turn it on. 
21. Repeat the above step linking J2 to J3, J3 to J4, J4 to J5, J5 to OF1 and so on, as 

shown in the supplied screenshot. 
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Note: If you make a mistake, switch back to the Select  button, select the entity and click 

the Delete  button in the toolbar or press the Delete key on the keyboard to delete the 

junction. Then you can return to the Add  button and continue adding manholes. It will 
be easier later if you rename some of the nodes to match the screenshot provided. You can 
also double click on the entity you are wanting to change and drag it to the desired position. 

22. Click the Select  button in the toolbar to escape from the Add shape mode. 
23. Turn on link arrows in the Map panel. 

24. Click on the Menu  button in the Map panel and select Preferences... 
25. Under the Map tab, check that the Show link arrow box is checked, if not, put a 

check in the box. 
26. Click OK to close.  
27. Check that the conduit flow directions match the screenshot provided. If you need 

to change the direction of a conduit click on the conduit, right click it and 
select Reverse link. 

 

Note: In PCSWMM, the Junction depth can be defined either by setting the Depth of the 
junction or by setting the Rim Elevation. Often when creating a model of a subdivision the 
Junction depths are unknown, however by defining the elevation of the rim, the depth can 
be automatically calculated by subtracting the Invert Elevation from the Rim Elevation. If 
the Depth attribute is being calculated (i.e. is disabled), select the Depth attribute and click 

on the Expression  button that appears in the value field. In the Auto-expression editor, 
click on the Calculate Rim Elev. instead button.    

For this exercise junction depths will be set to 6 ft | 2 m and inverts will be calculated 
assuming a constant slope. 
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28. Set all the junction depths to be 6 (ft) | 2 (m). 
29. Select the Junctions layer in the Layers panel and press Ctrl + A to select all the 

junctions. 
30. Enter 6 (ft) | 2 (m) for the Depth in the Attributes panel. If the Depth attribute is 

grayed out, then click on the Expression  button that appears in the value field. 
In the Auto-expression editor, click on the Calculate Rim Elev. instead button. Now 
you can enter the junction depth values.  

31. Click the Save  button. 

6.3 Set conduit attributes 

1. Select all the conduits. 
2. Click the Conduits layer in the Layer Panel. 
3. Select all of the conduits by pressing the Ctrl and A buttons on the keyboard.  
4. Change the attributes for the selected conduits in the Attributes Panel as follows: 

Roughness = 0.013 (new concrete pipe material) 

Cross-Section = CIRCULAR 

Geom1 = 3.5 (ft) | 1 (m) 

Now we need to assign invert elevations for all manholes in the system. As we need to meet 
the pipe slope design criteria of at least 1% and the outfall invert elevation is 146.7 (ft) | 45 
(m), PCSWMM can calculate the required invert elevations of all the other manholes in the 
drainage network. 

5. Click on the Tools  button. 
6. Click on the Set Slope tool listed at the bottom (in the Nodes, Conduits or Vertical 

detail sections). 
7. In the Set Slope tool, set the Set slope to 1 (%) 
8. Make sure that the Preserve node rim elevations box is turned off. 
9. Make sure that the Raise upstream nodes' invert elevation box is turned on. 
10. Make sure that the Apply to flatter conduits only box is turned off. 
11. Selected conduits only should be grayed out or left unchecked. 
12. Click on the Analyze… button. 
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13. A table of calculated changes appears for review; click Apply to implement them, 
and then on the Close button (please note that the screenshot provided is showing 
SI units, US units will differ). 

 

Note: If all 9 nodes are not listed under the Set Slope dialog, it may be because the flow 
direction is incorrect. You can display flow arrows to check flow direction. 

14. Select a pathway from J1 to OF1. 
15. In the Map Panel, click on junction J1 
16. Hold the Shift key down and click on the outfall OF1. A path of connecting entities 

should be selected.  
17. Click the Profile tab to view the profile. 

 

To display the invert elevations and pipe diameters as shown in the screenshot: 

18. Click the Properties  button in the Profile Panel. 
19. In the Profile Properties editor, under the Node section, ensure Invert elevation is 

checked. 
20. In the Link section, ensure Depth is checked. 
21. Click the Close button to exit the Profile Properties. 
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6.4 Assign inflows to junctions 

Sanitary sewer systems receive inflows based on the wastewater generation from 
contributing areas and any rain derived infiltration/inflow (RDII). This is in contrast to 
stormwater collection systems, where inflows are generated from the runoff response due to 
rainfall/snowmelt. For sanitary sewers, inflows are entered at junctions considering 
contributing area (sewershed) for each junction. Note the difference between the words 
subwatershed (contributing area generating runoff) and sewershed (contributing area 
generating wastewater and RDII). 

Inflows can be assigned as direct flow (i.e., a constant value or a variable time series), dry 
weather flow (average flow with time patterns), or RDII using triangular hydrographs. RDII is 
discussed in a hydrology article and explored in more detail in the hands-on exercise titled 
"Derive triangular unit hydrographs". 

For the first step, sewersheds should be delineated for each junction. You can create an 
empty shapefile and then add polygons to represent sewersheds 

Note: To create a new GIS layer please see the following how-to 
article: https://support.chiwater.com/77980/creating-a-new-layer. 

Once the sewersheds are delineated, wastewater generation can be determined in several 
ways. The most common method involves the sewershed population multiplied by the 
average daily wastewater generation rate. This can be based on the number of buildings in 
each sewershed multiplied by the average people per building or area multiplied by 
population density. Different land uses may also be considered. Another approach is to 
estimate wastewater generation based on water consumption (fraction of metered water 
data) 

For this example we are going to import an external GIS layer containing sewersheds for 
each junction. Wastewater generation rates will be calculated within this shapefile and 
assigned to the associated junctions (note the sewersheds are named to match junctions for 
easy data importation). We will create an additional two attributes in the shapefile to 
calculate average wastewater generation rate and inflow/infiltration. Alternatively you can 
import inflow values from an Excel/text file. 

https://secure.chiwater.com/Workbook/Exercise.aspx?pcswmmcode=2&ChapterID=27&ChapterNum=16&ScheduleID=134&WorkbookID=15&License=837662&Email=water@hydrosoft.co.kr&v=kjnyyjuAOkhsmcr1AVvJzS8rMUQ7nwi5TckpM%2bSmrtmMdEd0GuC%2boHzd9SVW0HgPFGqTV494go%2biqkB%2bTRfzpQgN6HGmIZLPMNih6MPMwJGOFgXVx5pCYgw7Z7rn2gXuQdgsE%2bLmYDs2TWujpjXUrcGm0T66az1oiMQkFo3uwaLu4uHyCyn%2fMvqtLLtEidqxzFZKyQhBEM4NrxScPFTdYJZTh0Z2Aq96wQIlPqugALmKjm%2fdn9ZRrrLk%2bLNaLSbPRDQqQ8%2bCgqTyMY6Do%2bmDXaIMKyBQWK8F6Kx6yx6pdR8%2foN7wi8DgCCC6ib8q%2bVXm
https://secure.chiwater.com/Workbook/Exercise.aspx?pcswmmcode=2&ChapterID=27&ChapterNum=16&ScheduleID=134&WorkbookID=15&License=837662&Email=water@hydrosoft.co.kr&v=kjnyyjuAOkhsmcr1AVvJzS8rMUQ7nwi5TckpM%2bSmrtmMdEd0GuC%2boHzd9SVW0HgPFGqTV494go%2biqkB%2bTRfzpQgN6HGmIZLPMNih6MPMwJGOFgXVx5pCYgw7Z7rn2gXuQdgsE%2bLmYDs2TWujpjXUrcGm0T66az1oiMQkFo3uwaLu4uHyCyn%2fMvqtLLtEidqxzFZKyQhBEM4NrxScPFTdYJZTh0Z2Aq96wQIlPqugALmKjm%2fdn9ZRrrLk%2bLNaLSbPRDQqQ8%2bCgqTyMY6Do%2bmDXaIMKyBQWK8F6Kx6yx6pdR8%2foN7wi8DgCCC6ib8q%2bVXm
https://secure.chiwater.com/Workbook/Exercise.aspx?pcswmmcode=2&ChapterID=27&ChapterNum=16&ScheduleID=134&WorkbookID=15&License=837662&Email=water@hydrosoft.co.kr&v=kjnyyjuAOkhsmcr1AVvJzS8rMUQ7nwi5TckpM%2bSmrtmMdEd0GuC%2boHzd9SVW0HgPFGqTV494go%2biqkB%2bTRfzpQgN6HGmIZLPMNih6MPMwJGOFgXVx5pCYgw7Z7rn2gXuQdgsE%2bLmYDs2TWujpjXUrcGm0T66az1oiMQkFo3uwaLu4uHyCyn%2fMvqtLLtEidqxzFZKyQhBEM4NrxScPFTdYJZTh0Z2Aq96wQIlPqugALmKjm%2fdn9ZRrrLk%2bLNaLSbPRDQqQ8%2bCgqTyMY6Do%2bmDXaIMKyBQWK8F6Kx6yx6pdR8%2foN7wi8DgCCC6ib8q%2bVXm


65 

 

1. Open the Sewersheds.SHP layer from the PCSWMM Exercises\ K027\Initial folder. 

2. Open the Map panel and click the Open layer  button. 

3. Click on the Open button and navigate to the folder PCSWMM 
Exercises\ K027\Initial, select Sewersheds.SHP and click Open.  

4. Click on Table panel and click on the sewersheds layer in the Layers panel. You 
should see attributes called AREA and NUM_HOUSES indicating the area and 
number of houses in each sewershed. 

5. Return to the Map panel and click on the sewersheds layer in the Layers panel, right 
click and select Unlock. A message will appear asking if you want to Unlock or 
Copy layer, click on the Unlock layer button. 

6. Right click the sewersheds layer in the Layers panel and select Restructure . 

 

7. In the dialog box that appears, click the Add  button and select Attributes to 
create a new attribute. 

8. Type name as Avg_wwrate. 
9. Enter the units to be gal/min/house (US) or L/sec/house (SI). 
10. Change the Data type: to Number. 

 

11. Click on the Add  button again and create another attribute called Infil. 
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12. Change the Data type: to Number. 
13. Click the Save button. 

Now to populate the two attributes created, we will use the Replace tool. The average 
wastewater generation rate is calculated assuming each house has on average 3.5 persons 
and a unit wastewater generation rate is 95 gal/person/day | 350 L/person/day (average 
daily flow can vary from 225 – 425 L/person/day, source: Gravity sanitary Sewer – Design and 
Construction, Second edition, 2007, ASCE Manuals and Report on Engineering Practice No. 
60, WEF Manual of Practice No. FD-5). 

This value can be used as the average value in dry weather flow. The sewer infiltration rate is 
assumed to be constant at 0.2 L/s/house and can be entered as a direct flow. Inflow and 
infiltration can be dependent on rainfall with a multiplier (L/s/ha/cm of rain) or it is possible to 
use RDII algorithms. It is recommended to use local data based on wet weather and dry 
weather flow monitoring. 

14. Click on sewersheds in Layers panel and press the Ctrl and A keys to select all the 
sewersheds. 

15. Click Replace  button in the Attributes panel. 
16. Ensure the layer selected is sewersheds, under Edit attribute select Avg_wwrate. 
17. Select Replace from the list of Favorites. 
18. Click on the Insert button and select NUM_HOUSES, as shown in the screenshot 

provided. 

 

The average wastewater generation rate (Avg_wwrate) for each sewershed will be replaced 
with the no. of houses within the sewershed. Now we will multiply that value by 0.23 
gal/min/house | 0.014 L/s/house (95 gal/person/day x 3.5 persons/house | 350 L/person/day 
x 3.5 persons/house) using the same Replace function. 

19. Next to [NUM_HOUSES] enter in an asterisk * for multiplication. 
20. Type the Value to be 0.23 gal/min/house | 0.014 L/sec/house (please note 

screenshot is in SI units, US will differ). 
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21. Click Apply. 
22. Similarly we will assign the Infil attribute using the Replace tool. 

23. If you have already closed the Replace tool, click on the Replace  button again. 
24. Ensure the layer selected is sewersheds, under Edit attribute select INFIL. 
25. Select Replace from the list of Favorites. 
26. Click on the Insert button and select AREA. 

 

27. Next to [AREA] enter in an asterisk * for multiplication. 
28. Type in the value to be 1.28 gal/min/ac | 0.2 L/sec/ha, as shown in the screenshot 

provided (please note screenshot is in SI units, US will differ). 
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29. Click Apply. 
30. Click Close to close the Replace tool. 

6.5 Assign inflows at junctions 

We will now import inflow values from the sewersheds GIS layer using the same Replace tool. 
In this case we are going to assign the infiltration rates to the associated junction by 
matching the Name attribute in the sewershed and Junctions layers. 

1. Select all the junctions. 
2. Click on Junctions in the Layers panel. 
3. Press Ctrl + A to select all the junctions.  

4. In the Attributes panel click Replace  button. 
5. Ensure the layer selected is Junctions, under Edit attribute select Baseline. 
6. Select the Insert button located above the Expression box and click on 

the Function tab. 
7. Select LLOOKUP from the list of functions. 

The LLOOKUP function will import attribute values from another layer provided it can match 
the ID of one layer with another. In this exercise we will set the Junction's Baseline value from 
the sewersheds layer INFIL attribute. Entities will be matched based on their names. 
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8. Put your cursor in the first set of square brackets, this is where the SourceLayer is 
defined, type in sewersheds. 

9. Put your cursor in the second set of square brackets, this is where 
the SourceAttribute is defined, type in INFIL. 

10. Put your cursor in the third set of square brackets, this is where the MatchAttribute is 
defined, type in Name. 

11. Put your cursor in the last set of square brackets, this is where 
the SourceMatchAttribute is defined, type in NAME. 

Note: the entities are matched by the Name attribute (the sewersheds were named to 
match junction names). 

 

12. Click Apply. 

13. Click Replace  button if the Replace tool was previously closed. 
14. Repeat the process from above. This time, edit the Junction's Average 

Value attribute to use the LLOOKUP function to match the sewersheds 
AVG_WWRATE value. Names will be used to match entities. 

15. Ensure the layer selected is Junctions, under Edit attribute select Average Value. 
16. Ensure the Selected entities only box is not checked. 
17. Select the Insert button located above the Expression box and click on 

the Function tab. 
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18. Select LLOOKUP from the list of functions. 
19. Put your cursor in the first set of square brackets, this is where the SourceLayer is 

defined, type in sewersheds. 
20. Put your cursor in the second set of square brackets, this is where 

the SourceAttribute is defined, type in AVG_WWRATE. 
21. Put your cursor in the third set of square brackets, this is where the MatchAttribute is 

defined, type in Name. 
22. Put your cursor in the last set of square brackets, this is where 

the SourceMatchAttribute is defined, type in NAME. 

 

23. Click on Analyze, Apply and Close. 

6.6 Assign time patterns 

Assigning inflows at junctions can be done in many ways. If a GIS layer containing 
sewersheds has not been prepared, values can be entered manually or imported from an 
Excel worksheet. Also data can be extracted from a GIS layer containing water meter 
readings, or based on land use/population density etc. 

1. Click on the downward arrow in the Project panel and click on Time Patterns. It will 
appear grayed out as there are no time patterns defined. 
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2. Click the Add button and under Name type Diurnal and set the Type to HOURLY. 
3. Enter the numbers from the table provided in the Time Pattern Editor. 
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4. Click OK. 
5. Assign the Diurnal pattern to all the junctions. 
6. Click on Junctions in the Layers panel and press Ctrl + A. 

7. In the Attributes panel, click on the Time Pattern 1 ellipsis . 
8. Select Diurnal and click on the Assign to the 9 selected junctions button. 

 

Note: The average wastewater generation rate and time patterns depend on the location 
as well as the land use of the contributing area. Therefore, you can have different average 
values and time patterns in the same model. If the data is available, SWMM5 allows using 
multiple time patterns to consider variability depending on the day or month of the year. 

6.7 Run the model 

Change the simulation duration to 150 hours. 

1. Click on Simulation Options in the Project panel. 
2. Click on the Dates tab and change the Duration to be 150 hrs.  
3. Note: If you examine the General tab, you will see only Flow routing is checked as in 

this exercise only hydraulics are simulated (i.e., there are no subcatchments 
involved, so hydrology is not simulated).    

4. Click the Run  button in the toolbar to save the project and run a simulation. If 
the run is successful, a pop-up window will show in the bottom right corner of the 
PCSWMM window with the message, ‘Run was successful’ along with Continuity 
Error information. 

5. Check that the continuity errors are reasonable (say less than 5%, depending on the 
design accuracy required). 

6. Click on the Status tab to open the Status panel. 
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7. Click on the Continuity Errors section. 
8. Check the routing continuity.  

It may seem counter-intuitive, but drops and losses are assigned after the pipes are sized. This 
is because pipe sizing uses the Manning’s formula which does not take into account 
manhole drops. In addition, minimum pipe drops need to be assigned after the pipes are 
sized as this sequence saves repeating steps. Once the drops are added and the model 
rerun, the pipe capacity results should be checked, along with the profiles, and pipe sizes 
adjusted as necessary. Although the sequence of steps suggested here is more efficient, 
there is, however, no harm in assigning drops and losses before the pipes are sized, and then 
executing the drops and losses tool after the pipes are sized. 

6.8 Size the pipe diameters 

PCSWMM will compute the minimum circular pipe diameter that will not flow full, provide the 
nearest standard pipe diameter, and apply them to the model (i.e. update the input data 
file accordingly). 

1. In the Map panel, click on the Tools  button and in the Conduits sections, click 
on the Pipe Sizing tool. 

2. Set the Minimum diameter to 0.667 ft | 0.2 m, select the option to preserve 
pipe Invert elevation. Ensure Selected conduits only is not checked. 

3. Click the Analyze… button (note that the screenshot is in SI units, US units will differ). 

 

4. Compare Original Diameter and New Diameter in the Pipe Sizing preview table, 
and click on the Nodes tab to see the computed changes to the invert elevations 
due to pipe resizing. You may see most if not all of the pipes are resized to the 
minimum pipe diameter. 
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5. Click Apply to implement the changes and click on the Close button to exit 
the Pipe Sizing tool. 

6.9 Set Drops/Losses 

Now we need to adjust the drops across each manhole. In this example we will assign a drop 
of 0.1 ft | 0.03 m for a straight-through pass and 0.49 ft | 0.15 m for a 45 degree to 90 degree 
bend at a manhole. For this process; 

1. In the Map Panel click on the Tools  button and click on the Set Drops/Losses tool 
(in the Conduits or Vertical detail sections). 

2. In the drop-down menu Calculate: select Both drops and losses (should be default). 
3. Enter the Angle, Drop and Loss Coef. values as shown in figures provided (please 

note that two screenshots showing the values for both US and SI units are provided). 

Note: It is recommended to enter drops/losses for other additional angle ranges however for 
the sake of the exercise the two angles are sufficient to illustrate the process. 
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4. Make sure that the Apply as minimum criteria and Preserve conduit slopes boxes 
are all checked. 

5. Click Analyze. 

View Status report to ensure that two of the outlet offsets and exit loss coefficients are the 
same (If you see 2 different conduits with the same values you may have simply created your 
conduits in a different order, and thus they have different names. Check the original set up of 
the conduits to ensure they are in the same location as shown above - in this example, the 
conduits with the largest exit angles are C4 and C8). 
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6. Click Apply to apply the changes and then click the Close button. 
7. Set an Entry Loss Coefficient of 0.1 for all the conduits. 
8. Click on the Conduits layer in the Layers panel and click Ctrl + A to select all of the 

conduits. 
9. In the Attributes panel enter an Entry loss coefficient of 0.1.  

10. Click on the Run  Simulation button on the toolbar to save the project and 
regenerate the results. 

6.10 View and interpret the results 

We will now ensure that the minimum velocity criteria are being met, 

Plot the velocity through all the conduits. 

1. Click the Graph tab to open the Graph Panel. 
2. In the Time Series Manager, expand Links > Velocity. 
3. Select all the conduits (from 1 to 9) by right-clicking Velocity and choosing Select 

All from the pop-up menu.  

Note: The Graph Panel can also be used to plot the flows in all the conduits as well as the 
depths in all nodes in the system. 
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Note: Your plot of velocities should be similar to the above plots. The peak velocities should 
exceed the minimum self-scouring velocities specified by your local approval agency 
(commonly about 2 ft/s | 0.6 m/s). In this design, not all upstream pipes achieve their 
respective self-cleansing velocities due to small drainage areas, so maintenance may be 
required to avoid sedimentation. 

4. Check that the continuity errors are less than 5%. 
5. Click on the Status tab to open the Status panel. 
6. Click on the Continuity Errors section. 
7. Check the routing continuity.  

6.11 Setup pump and the force main 

Now for this simple exercise, we will assume wastewater is collected at a sump and pumped 
to a wastewater treatment plant. This will include adding a pump to the model and a force 
main that will convey wastewater to the treatment plant. For this purpose we will use Hazen-
Williams equation (options available are Hazen-Williams, Darcy-Weisbach or simply Manning's 
equation). 

1. Click on the Map tab to open the Map panel. 
2. Right click on the outfall OF1 and select Convert > Storage from the drop-down 

menu. 

 

3. In the Attributes panel, change the Name to SU1, the Invert Elevation to 131.2 ft 
| 40 m, the Depth to 23 ft | 7 m, the Storage Curve to FUNCTIONAL, 
the Coefficient to 0 and change the Constant to 40 ft2 | 4 m2 as shown in the table 
provided. 

 



78 

 

4. Select the conduit discharging into the pond/outfall (C5 in this case) and change 
the Outlet Offset to 16.4 ft | 5 m 

We will now add an outfall representing the wastewater treatment plant. 

Use your mouse scroll wheel to zoom out (scroll down) until you can see the river. 

5. Select Outfalls in the Layers panel, It will appear grayed out as there are currently 
no outfalls in the model. 

6. Click the Add  button and click beside the river to add an outfall as shown in the 
screenshot provided. 

 

7. In the Attributes panel, change the Name to Outfall and set the Invert El. to 144 ft | 
44 m. 

8. Click on the Select  button to get out of Edit mode. 

We will now add the force main by drawing a conduit 

9. Click on the Junctions layer in the Layers panel and click on the Add  button. 
10. Click beside the storage unit SU1 to draw a junction and, while holding the Shift key, 

click midway between SU1 and the Outfall to add another junction and a conduit 
link, as shown in the screenshot provided. 
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Note: The new junction, J10, represents the header of a pump while J11 is an intermediate 
location in the force main. The conduit C10 joining J10 and J11 represents half of the force 
main. 

We will now add a second conduit linking J11 to the outfall. Conduits C10 and C11 represent 
the force main. 

1. Click on the Conduits layer in the Layers panel and click on the Add  button if 
you are not already in add/edit mode. 

2. Click once on J11 and then click on the Outfall to add a conduit. 

3. Click on the Select  button to get out of Edit mode. 
4. Select conduits C10 and C11 by first selecting C10, and while holding down 

the Ctrl key, selecting C11. 
5. In the Attributes panel change their lengths to 2450 ft | 750 m. 
6. In the Attributes panel, click in the Cross-section attribute box and click 

the ellipsis  button to open the Cross-section Editor. 
7. Change the cross-section to Force-Main and change the Max. Depth to 0.5 ft 

| 0.15 m. 
8. In the Roughness box enter a value of 120, this roughness value represents the 

Hazen-Williams C-factor to 120. Click OK. 

Note: By default PCSWMM uses the Hazen-Williams equation for force mains. You can 
change this by selecting Simulation Options under the Project panel and, under the Dynamic 
Wave tab, selecting Darcy-Weisbach under the Force main equation section.   

9. Select junctions J10 and J11 (while pressing Ctrl key) and change the Surcharge 
depth to 160 ft | 50 m. Assigning a large surcharge depth allows pressurized flow at 
the nodes without flooding. 
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10. Click on J10 and assign it an Invert Elevation of 138 ft | 42 m. 
11. Click on J11 and assign it an Invert Elevation of 164 ft | 50 m. 

We will now add a pump between storage node SU1 and Junction J10. 

12. Click on the Zoom  button and draw a box around J10 and SU1. 

13. Select the Pumps layer from the Layers panel and click Add  button. The pumps 
layer will appear grayed out as there are currently no pumps in the model. 

14. Click first on SU1 and then J10 to draw the pump. 

 

15. In the Attributes panel, specify the Startup depth as 13 ft | 4 m. 
16. Specify the Shutoff depth as 1.6 ft | 0.5 m. 

17. In the Pump Curve attribute click on the ellipsis  button. 
18. Click on the Add button in Pump Curve Editor. 
19. Change the Name to Pump1 and select Pump type as TYPE3. 

Enter the following numbers from the screenshots provided in the image, please note both US 
and SI units have been provided: 
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20. Click Assign to Pump P1 button. 

Note: Pump operation can also be modified using Control Rules.    

6.12 Run the model 

1. Click the Run  button in the toolbar to save the project and run a simulation. If 
the run is successful, a pop-up window will show the message, ‘Run was successful’, 
with Continuity Error information. A model containing pumps and force mains may 
experience instabilities and high continuity errors. If this happens, you may have to 
try smaller routing time steps to get acceptable results. 

2. Check that the continuity errors are reasonable (say less than 5%, depending on the 
design accuracy required). 

3. Click on the Status tab to open the Status panel. 
4. Click on the Continuity Errors section. 
5. Check the routing continuity.  
6. Plot flow in the pump to see how it was operated. 
7. Switch to the Graph panel. 
8. Expand the Time Series Manager > Links > Flow > P1), please note that the 

screenshot provided is in SI units, US units will differ.  
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7. Evaluation of in-line stormwater 
pond TSS removal 

Water quality has become an important design criteria for many stormwater practices. 
Stormwater pond effectiveness is often based on the total suspended solids (TSS) removal, for 
example Section 4.2 of the Toronto and Region Conservation Authority (TRCA) Stormwater 
Management Criteria (2012) states that all watercourses and water bodies within TRCA’s 
jurisdiction require an enhanced level of water quality protection, equivalent to 80% TSS 
removal. 

TRCA guidelines, based on Ontario Ministry of the Environment Stormwater Management 
Planning and Design Manual (2003), provide water quality storage requirements to achieve 
long-term suspended solids removal. Providing an alternative modeling approach, this 
exercise illustrates how to determine the loading rates at the inlet and outlet of a stormwater 
pond and thereby determine the percentage removal for TSS considering particle settling in 
the pond. 

 

7.1 Opening and running the to-be model 

1. Unpackage Valleyfield pond TSS removal.pcz from the PCSWMM 
Exercises\K024\Initial\ folder. 

2. Open PCSWMM Exercises\K024\Initial\ and select Valleyfield pond TSS 
removal.pcz. 

3. Click the Open button. 
4. A dialog will appear showing a default location to unpackage the model: click on 

the Unpackage button then the OK button.  

5. Click on the Run  button in the Project panel to run the model. 

7.2 Evaluating the performance of the pond 

TRCA guidelines, based on Ontario Ministry of the Environment Stormwater Management 
Planning and Design Manual (2003), provides water quality storage requirements to achieve 
long-term suspended solids removal. 

https://www.youtube.com/embed/NMp2j89h5qs
https://www.youtube.com/embed/NMp2j89h5qs
https://www.youtube.com/embed/NMp2j89h5qs
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To determine water quality storage requirement for long-term SS removal at the pond, it is 
required to estimate total area and the imperviousness of the catchment. 

1. Select all the subcatchments. 
2. Select the Subcatchments layer in the Layers panel. 
3. Press Ctrl+A to select all the subcatchments in the map.  

Note: In this exercise all the subcatchments drain to the pond. In a larger model only a few 
subcatchments may be draining to any particular pond. In that case the catchment of the 
pond can be selected by selecting the pond storage unit in the map and using Find tool. 
Click Select Upstream and then select Subcatchments in the Layers panel.    

4. The Attributes panel should indicate all the subcatchments are selected (9 in this 
exercise). 

5. Scroll down in the Attributes panel to Shape to obtain statistics for all the 
subcatchments. 

 

6. On a scrap piece of paper, calculate imperviousness using the SWMM 
Area and Imperv. Area values using the equation below: 

7. Determine the required storage requirement as per the table below. This table is for 
context only and is only provided in SI units. 

8. Shown in SI units 

Note: The table below shows the water quality storage requirements for Ontario, Canada, as 
specified by the Ministry of the Environment. Please note this figure was added to add 
context to the exercise and is not required to complete the exercise. Source: Stormwater 
Management Planning and Design Manual, March 2003, Ministry of the Environment, Ontario, 
Canada.
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Note: As an alternative to the above procedure, PCSWMM provides a modeling approach 
to evaluate the performance of a stormwater management facility using water quality 
simulation. Long-term SS removal can be evaluated considering treatment occurring at the 
facility. This exercise presents SS removal modeling in PCSWMM/SWMM5 in a stormwater 
management pond simulating particle settling as described in the previous chapter. SS 
removal represents the reduction in TSS loading in the outflow of the pond in comparison to 
TSS loading in the inflow. 

7.3 Deriving TSS load estimates 

It is possible to estimate system wide TSS percent removal by considering inflow TSS load and 
mass reacted: 
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SWMM5 outputs water quality time series as concentrations (mg/L). To obtain pollutant 
loadings, we need to multiply the concentration by the flow. This is done after the SWMM run 
by deriving the TSS loading from SWMM5 output with the Graph panel’s Derive tab. 

1. Open the Status panel and check that the water quality runoff and routing 
continuity errors are acceptable. 

2. To generate the TSS loading time series upstream and downstream of the pond: 
3. Switch to the Map panel and select the links immediately upstream and 

downstream of the pond. 
4. Click on conduit C8. 

5. Click on the Find  button. 
6. Choose Select Downstream. Conduit C8 and PondOutlet outlet link will be selected. 

 

7. Switch to the Graph panel and click on Tools  > Derive Time Series. 
8. Select Pollutant loading from the list of functions. 
9. Click on the Add button next to the Locations text box and choose Selected Map 

Entities from the menu. The two selected entities should appear in the list of 
locations. 

10. Check the box next to TSS item in the list of pollutants in the screenshot. 

 

11. Click on the Create button to create the derived pollutant loading time series for 
the selected pollutants and locations. 

12. Plot the newly created TSS loading time series by selecting them from the 
created .tsd file in the Time Series Manager. 
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7.4 Long-term SS removal based on TSS loads 

In the Graph panel click on Tools  > Objective Functions. 

Select TSS (mg/s) from the Objectives functions for drop-down menu. 

 

Zoom into an event to see the performance of the pond at an individual event level. 

It is possible to determine SS percent removal by considering the total TSS loads at inlets (i.e. 
conduit C8) and outlets of the pond (i.e. conduit PondOutlet) from the Objectives tab): 

 

Since the long-term removal is of interest, the SS load should be extracted from the whole 
simulation period (not on an event basis). If there is more than one inlet or outlet, they should 
be considered to calculate % SS removal. As it is, the current pond design may not meet the 
required % SS removal (approximately 60% SS removal). 

1. Return to the Map panel and click on the pond to select it. 
2. In the Attributes panel for the pond, revise the pond storage curve by changing 

the constant in the storage function from 400 m2 | 4300 ft2 to 800 m2 | 
8600 ft2 (making the pond area larger, thereby reducing water depths). 

3. Run  the model again. 
4. Switch to the Graph panel and recalculate % SS removal. Notice the % removal 

increased from ~60% to ~71%. 

Changing the storage curve as well as outlet settings, permanent pool volume etc. also 
affects the pond performance. Using different particle size ranges considering particle size 
distribution (see Chapter 21) will also affect the results. 
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8. Water quantity with LIDs 

The objective of this exercise is to demonstrate how different LID practices are represented in 
SWMM5/PCSWMM and how their performance can be evaluated. In this model there are 9 
subcatchments, each representing a single LID or homogeneous land surface. The treatment 
train aims to route runoff from impervious surfaces (streets, roofs and parking lots) to pervious 
and lot level LID subcatchments. 

 

8.1 Setting up the model 

For this model the subcatchments have already been drawn and the subcatchment 
parameters have been estimated, however the subcatchment connectivity (where 
subcatchment runoff is routed to) must first be defined. 

1. Unpackage the OldsCollege-LIDs(1).pcz file from the PCSWMM 
Exercises\K026\Initial\ folder. 

2. Launch PCSWMM and select Open from the File tab menu. 
3. Browse to PCSWMM Exercises\K026\Initial\ and open OldsCollege-LIDs(1).pcz. 
4. Click Unpackage followed by OK. The model will be unpackaged in the correct 

location (\PCSWMM Exercises\K026\Initial).  

In this exercise we will be using the LID editor to define 4 different LIDs: 

a) Rainwater Harvesting (Rain barrel), 

b) Bio-retention Cell, 

c) Absorbent Landscaping, and 

d) Permeable parking lot (Porous Pavement). 

For this model the connectivity is set up as follows: 

Subcatchment S3 (Roof) is collected by a rainwater harvesting system and from there routed 
to a stormwater pond via conduit. 

https://www.youtube.com/embed/aUSxNiJt6NA
https://www.youtube.com/embed/aUSxNiJt6NA
https://www.youtube.com/embed/aUSxNiJt6NA
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Subcatchment S1A (Roof) is routed first to subcatchment S1B (Absorbent landscaping) from 
there routed to subcatchment S7 (Bio-retention area) and finally to the stormwater pond. 

Subcatchment S2 (Street) is also routed to subcatchment S7 (Bio-retention area) and from 
there routed to the stormwater pond. 

Subcatchment S5 (Parking lot) is routed first to an oil and grit separator and from there to the 
stormwater pond. 

Subcatchment S4 (Parking lot) is first routed to subcatchment S4A (Permeable pavement) 
and from there to the stormwater pond. 

For this exercise we have already created a model and setup the connectivity. You will start 
by setting up the LIDs. 

Parameter values for the LID layers can be obtained from the Reference tables on the 
PCSWMM support site, as well as through engineering drawings, and other hydrology 
literature values in textbooks and reports. The Reference tables include values for surface 
roughness, and soil infiltration parameters. In addition, the LID Control Editor reference article 
on the PCSWMM support site offers guidance for other LID parameters, such as clogging 
factors and drain coefficients. 

We begin by defining the rainwater harvesting LID. 

5. Click the downward arrow in the Project panel and select LID Controls to open 
the LID Control Editor. It will appear grayed out as there are currently no LID objects 
defined in the model. 

6. Click the Add button to create a LID control. 
7. Re-name the newly created LID to RainwaterHarvesting. 
8. Set the LID type to Rain Barrel. 
9. Enter the properties for the Storage and Underdrain layers as shown. 

https://secure.chiwater.com/Workbook/Exercise.aspx?pcswmmcode=2&ChapterID=26&ChapterNum=20&ScheduleID=134&WorkbookID=15&License=837662&Email=water@hydrosoft.co.kr&v=kjnyyjuAOkhsmcr1AVvJzS8rMUQ7nwi5TckpM%2bSmrtmMdEd0GuC%2boHzd9SVW0HgPFGqTV494go%2biqkB%2bTRfzpQgN6HGmIZLPMNih6MPMwJGOFgXVx5pCYgw7Z7rn2gXuQdgsE%2bLmYDs2TWujpjXUrcGm0T66az1oiMQkFo3uwaLu4uHyCyn%2fMvqtLLtEidqxzFZKyQhBEM4NrxScPFTdYJZTh0Z2Aq96wQIlPqugALmKjm%2fdn9ZRrrLk%2bLNaLSbPRDQqQ8%2bCgqTyMY6Do%2bmDXaIMKyBQWK8F6Kx6yx6pdR8%2foN7wi8DgCCC6ib8q%2bVXm
https://secure.chiwater.com/Workbook/Exercise.aspx?pcswmmcode=2&ChapterID=26&ChapterNum=20&ScheduleID=134&WorkbookID=15&License=837662&Email=water@hydrosoft.co.kr&v=kjnyyjuAOkhsmcr1AVvJzS8rMUQ7nwi5TckpM%2bSmrtmMdEd0GuC%2boHzd9SVW0HgPFGqTV494go%2biqkB%2bTRfzpQgN6HGmIZLPMNih6MPMwJGOFgXVx5pCYgw7Z7rn2gXuQdgsE%2bLmYDs2TWujpjXUrcGm0T66az1oiMQkFo3uwaLu4uHyCyn%2fMvqtLLtEidqxzFZKyQhBEM4NrxScPFTdYJZTh0Z2Aq96wQIlPqugALmKjm%2fdn9ZRrrLk%2bLNaLSbPRDQqQ8%2bCgqTyMY6Do%2bmDXaIMKyBQWK8F6Kx6yx6pdR8%2foN7wi8DgCCC6ib8q%2bVXm
https://secure.chiwater.com/Workbook/Exercise.aspx?pcswmmcode=2&ChapterID=26&ChapterNum=20&ScheduleID=134&WorkbookID=15&License=837662&Email=water@hydrosoft.co.kr&v=kjnyyjuAOkhsmcr1AVvJzS8rMUQ7nwi5TckpM%2bSmrtmMdEd0GuC%2boHzd9SVW0HgPFGqTV494go%2biqkB%2bTRfzpQgN6HGmIZLPMNih6MPMwJGOFgXVx5pCYgw7Z7rn2gXuQdgsE%2bLmYDs2TWujpjXUrcGm0T66az1oiMQkFo3uwaLu4uHyCyn%2fMvqtLLtEidqxzFZKyQhBEM4NrxScPFTdYJZTh0Z2Aq96wQIlPqugALmKjm%2fdn9ZRrrLk%2bLNaLSbPRDQqQ8%2bCgqTyMY6Do%2bmDXaIMKyBQWK8F6Kx6yx6pdR8%2foN7wi8DgCCC6ib8q%2bVXm
https://secure.chiwater.com/Workbook/Exercise.aspx?pcswmmcode=2&ChapterID=26&ChapterNum=20&ScheduleID=134&WorkbookID=15&License=837662&Email=water@hydrosoft.co.kr&v=kjnyyjuAOkhsmcr1AVvJzS8rMUQ7nwi5TckpM%2bSmrtmMdEd0GuC%2boHzd9SVW0HgPFGqTV494go%2biqkB%2bTRfzpQgN6HGmIZLPMNih6MPMwJGOFgXVx5pCYgw7Z7rn2gXuQdgsE%2bLmYDs2TWujpjXUrcGm0T66az1oiMQkFo3uwaLu4uHyCyn%2fMvqtLLtEidqxzFZKyQhBEM4NrxScPFTdYJZTh0Z2Aq96wQIlPqugALmKjm%2fdn9ZRrrLk%2bLNaLSbPRDQqQ8%2bCgqTyMY6Do%2bmDXaIMKyBQWK8F6Kx6yx6pdR8%2foN7wi8DgCCC6ib8q%2bVXm
https://secure.chiwater.com/Workbook/Exercise.aspx?pcswmmcode=2&ChapterID=26&ChapterNum=20&ScheduleID=134&WorkbookID=15&License=837662&Email=water@hydrosoft.co.kr&v=kjnyyjuAOkhsmcr1AVvJzS8rMUQ7nwi5TckpM%2bSmrtmMdEd0GuC%2boHzd9SVW0HgPFGqTV494go%2biqkB%2bTRfzpQgN6HGmIZLPMNih6MPMwJGOFgXVx5pCYgw7Z7rn2gXuQdgsE%2bLmYDs2TWujpjXUrcGm0T66az1oiMQkFo3uwaLu4uHyCyn%2fMvqtLLtEidqxzFZKyQhBEM4NrxScPFTdYJZTh0Z2Aq96wQIlPqugALmKjm%2fdn9ZRrrLk%2bLNaLSbPRDQqQ8%2bCgqTyMY6Do%2bmDXaIMKyBQWK8F6Kx6yx6pdR8%2foN7wi8DgCCC6ib8q%2bVXm
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10. Once entered keep the LID Control Editor open (please note the screenshot shown 
is in SI units, US units will differ). 

 

Now we will set up a bioretention area LID. 

11. Add another LID named BioretentionArea. 
12. Click the Add button again in the LID Control Editor to add a second LID. 
13. Re-name the newly created LID to BioretentionArea.  
14. Select the LID type to be Bio-Retention Cell. 
15. Enter the properties for the Surface, Soil, Storage and Underdrain layers as shown in 

the image. 
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16. Once entered keep the LID Control Editor open (please note the screenshot shown 
is in SI units, US units will differ). 
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We will now set up the parameters for the Permeable pavement LID. 

17. Add another LID called PermeablePavement. 
18. Click the Add button again in the LID Control editor to add a third LID. 
19. Re-name the newly created LID to be PermeablePavement.  
20. Select the LID type to be Permeable Pavement. 
21. Enter the properties for the Surface, Pavement, Soil, Storage and Underdrain layers 

as shown. 

 

22. Click OK to close the LID Control Editor (please note the screenshot shown is in SI 
units, US units will differ).. 
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23. Click the Save  button in the Project panel to save your model. 

8.2 Assigning the LIDs to subcatchments 

We now assign the LID subcatchments from the list of newly created LIDs. We’ll begin with 
subcatchment S3. Subcatchment S3 represents the roof of an entire building that was 
retrofitted with a rainwater harvesting unit, which will be represented as a rain barrel LID. 
Please note that it is assumed that this building has a green roof that makes up 20% of the 
roof area and thus the subcatchment has an imperviousness of 80%. 

1. Select S3 from the Subcatchments layer in the Map panel. 

2. Click in the LID Controls in the Attributes panel and click on the ellipsis  button. 
3. Click on the Add button. 
4. Select RainwaterHarvesting from the LID control name drop-down list. 
5. Assign the Area of each unit as 161 ft2|15 m2 (assumes a 2 m high rainwater 

collection tank with 15 m2 surface area). 
6. The Surface width per unit (ft | m) is not applicable for rain barrels, so we will leave 

the default value of 0. 
7. Change the % initially saturated to 15 and the % of impervious area treated to 

be 100. 
8. Leave the % of pervious area treated as 0. 
9. Check Return all outflow to pervious area. 
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By sending outflow to a pervious area we simulate the situation where collected rainwater is 
used for irrigation within the subcatchment. If the harvested water is reused for other 
purposes you can use a storage unit with a pump. Now we’ll specify a location to save the 
detailed LID report for S3. 

10. In the LID Usage Editor click on the Open  button adjacent to the Detailed report 
file. 

 

11. Browse to PCSWMM exercises\K026\Initial\ and create a new folder called LID 
reports and double click on the new folder. PCSWMM will name the report file S3 
RainwaterHarvesting.txt by default. 

12. Click Save and OK to close the LID Usage Editor. 
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Note: Although we are specifying the location of the LID detailed reports the report files will 
not be created until after SWMM5 has been run.    

Now let’s set up LID properties for subcatchment S7 or the bioretention area. 

13. Select S7 from the Subcatchments layer in the Map panel. 

14. Click in the LID Controls in the Attributes panel and click on the ellipsis  button. 
15. Click the Add button. 
16. Select BioretentionArea from the LID control name drop-down list. 
17. Check LID occupies full subcatchment. This will automatically change the area of 

the LID to be 100% of the subcatchment occupied. 
18. Change the % initially saturated to 15 (please note the screenshot shown is in SI 

units, US units will differ). 
19. Leave the % of pervious area treated as 0. 
20. We need to specify a location to save the detailed LID report for S7. 
21. In the LID Usage Editor click on the Open button, browse to PCSWMM 

exercises\K026\Initial\LID reports, PCSWMM will name the report S7 
BioretentionArea.txt. 

22. Click Save to close the Browse window and OK to close the LID Usage Editor. 

 

Now set up the LID properties for subcatchment S4A (the permeable pavement area). 

23. Select subcatchment S4A from the Subcatchments layer in the Map panel. 

24. Click the LID Controls in the Attributes panel and click on the ellipsis  button. 
25. Click on the Add button. 
26. Select PermeablePavement from the LID control name drop-down list. 
27. Check LID occupies full subcatchment. 
28. Change the Surface width per unit (ft | m) to 66 ft |20 m, the % initially saturated 

to 15 and the % of impervious area treated to 100 as shown in the following 
screenshot (please note the screenshot shown is in SI units, US units will differ). 

29. Leave the % of pervious area treated as 0. 
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Let’s specify a location to save the detailed LID report for S4A. 

30. In the LID Usage Editor click on the Open button, browse to PCSWMM 
exercises\K026\Initial\LID reports. 

31. Click Save to close the Browse window and OK to close the LID usage editor. 

8.3 Loading continuous rain gage time series data 

We will now run the model using a continuous long-term time series file. For this example, the 
units for the rainfall will be left as mm (even for US units) as the original precipitation data is in 
mm. Let’s begin by creating a rain gage. 

1. Add a new rain gage named RG3031093. 
2. Click on the Rain Gages item in the Project panel. It will appear gray as there are 

currently no Rain Gages in the model. 
3. Click on the Add button in the Raingage Editor under the Rain Gages tab. 
4. Change the Name to RG3031093.  
5. Set the Rain Format to INTENSITY (default) and set the Time interval to 1:00 (default). 
6. Set the data source to be from a FILE called GRPextractor_calgary-

123_15122011_125824.txt file from the PCSWMM exercises \K026\Initial\Time 
series folder. 

7. Under the Data Source field, select FILE. 

8. Click on the ellipsis  button in the File Name field and navigate to PCSWMM 
exercises \K026\Initial\Time series. 

9. In order to see the time series, change the Filter from .dat to show All files in the 
open dialog. 

10. Select GRPextractor_calgary-123_15122011_125824.txt and click the Open button. 
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11. In the Station ID field type in 3031093. 
12. Set the Rain Units to be MM (for US units as well). 
13. Check Plot data file time series to display the time series in the preview window. 
14. Click OK button to close the Raingage Editor. 

Note: In this exercise we are using Environment Canada rain gage data directly from the 
source file. 

 

15. Assign the RG3031093 rain gage to all the subcatchments. 
16. Click on the Subcatchments from the Layers panel. 
17. Press Ctrl + A to select all nine subcatchments. 
18. Click on the Rain Gage attribute field in the Attributes panel and 

select RG3031093 from the drop-down list. 
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8.4 Running the model 

Now we’ll set the simulation options to run a 4 year simulation (1991-1994). 

1. Change the SWMM engine to SWMM5.1.013 by clicking on the SWMM version 
number box located at the bottom of the interface. 
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2. Click on the Simulation options from the Project panel. 
3. Click on the Dates tab and set the Start analysis on to 01/01/1991 and End analysis 

on to 11/30/1994 at 12:00:00. This can be easily done by first setting the start date 
and then entering 34308 hours in the Duration box. 

 

4. Click on the Time Steps tab in the Simulation Options editor and change 
the Reporting time step to 10 min, the Dry weather runoff time step to 30 min, 
the Wet weather runoff time step to 5 min, and the Routing time step to 30 s. 

 

5. Click on the OK button to close the Simulation Options. 

6. Click on the Run  button in the Project panel to run the model. 



99 

 

8.5 Results comparison 

1. Click on the Status panel tab to review the result summary report. 
2. Click on LID Results from the list of sections in the Status panel. 
3. Review the LID Performance Summary and check that the reported losses are 

reasonable. 

The flow volume reduction in each LID considering total inflow and surface outflow can be 
calculated using the following equation (click view to display equation): . These percentages 
can be used in the water quality simulations. 

 

4. Click on the Graph tab to open the Graph panel. 
5. Open up all three LID detailed report files from the PCSWMM 

exercises\K026\Initial\LID reports folder. 

6. Open LID report files by clicking on the Open  button and navigating 
to PCSWMM exercises\K026\Initial\LID reports. 

7. Select all three LID reports by holding Shift while clicking on each of them. 
8. Click Open to open the LID reports.  
9. Plot the runoff time series by expanding Subcatchments > Runoff and 

select S1A and S1B. 
10. Click on Tools > Objective Functions. 

Compare the LIDs in terms of peak flows and runoff volumes. Because subcatchment S1A is 
100% impervious and S1B is completely pervious (0% impervious), the Runoff from S1B should 
be significantly less (about half). 

11. Click on the Menu  button in the Graph panel and select Clear Graph. 

Now plot the Runoff for S1B, S2 and S7. The total runoff treated by S7 can be calculated by 
adding the total runoff from S1B and S2 (~48 090 ft3 |1361.8 m3 ) and subtracting the total 
runoff from S7 (~13 066 ft3 |370 m3). 

Repeat steps 9 and 10 by plotting the runoff for subcatchments S4 and S4A. In this 
case S4A receives all the runoff from subcatchment S4 (parking lot). You will notice that the 
runoff from S4 is significantly larger than the runoff coming off of subcatchment S4A as there 
is permeable pavement treating the runoff. 

Plot the System rainfall by expanding System > Rainfall and select System. Notice how the 
Subcatchment S4A has more runoff than S4 during the larger events. This is because during 
these events the LID would overtop due to the high intensity rainfall. 

8.6 Evaluating LID quantity 

We will now evaluate the effect of LIDs on flow quantity by comparing results with a model 
scenario for the area without LIDs. 

1. Duplicate the current scenario and name it OldsCollege-No LIDs. 

2. Click on the Plan  button in the toolbar of the Project panel. 
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3. In the Scenario Manager, click on the Add  button and select Duplicate Current 
Project. 

4. Name the project OldsCollege-NoLIDs. 
5. In the Description (Title) box edit the text to read Olds College water quantity 

analysis – No LIDs. 
6. Click the Create button to close the Create Scenario window.  

7. Open the new scenario With the Scenario manager  still open click on the newly 
created scenario OldsCollege-NoLIDs and click Open. 

Choose to Save project if asked.  

8. Delete all the LID controls. 
9. Click LID Controls in the Project panel. 
10. Select all of the LID controls. 
11. Click the Del button, then click OK.  
12. When asked whether to remove all references to deleted LID controls from 

subcatchments, select Yes. Now this scenario model does not have any LIDs. 

13. Click on the Run  button in the Project panel to run the model. 
14. In the Time series manager (in the Graph panel) expand the Nodes>Total 

inflow>PondOF and examine the flow coming into the pond. Observe the results. 

15. Click on the Scenarios  button, check both scenarios and then Compare 
Scenarios to display the results of both runs. 

 

Confirm the reduction in flow with LIDs by zooming in to individual events. Also observe 
additional flow occurring only with LIDs. Check the pond source by plotting subcatchment S3 
runoff (Rain barrels release water after a 48 hour delay). 

1. Expand Subcatchments>Runoff>S3 
2. We can also compare model results by using the Summary/Comparison tool. 

3. In the Map panel, click on the Tools  button and select Summary/Comparison. 

4. In the Project Summary/Comparison window, click the Show Scenarios  button. 
Check the boxes next to the OldsCollege-LIDs 
(1) and OldsCollege_No_LIDs scenarios and click Refresh. 

5. Under Summary Tables, compare the the scenarios by selecting Runoff quantity 
continuity, Results statistics, Subcatchment attributes etc. 
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